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Welcome to the TekExpress® PCI Express Automated Test Solution Software
application (referred to as TekExpress PCle or PCle in the rest of the document).
TekExpress PCle provides an automated, simple, and efficient way to test PCI
Express interfaces and devices consistent to the requirements of the PCI Express
specifications.

Tek Express PCle key features and benefits
New features from current release
= Supports PCIE4.0 Base Spec with SigTest v4.0
= Migrated to New TekExpress Framework v4.2.10
= Migrated to Windows 64-Bit platform from 32-Bit
m  Included Genl,2,3,4 with Test Names for quick access
= Improved Switch and DUT toggle mechanism

= Deploys SigTest v3.2.0 and v4.0 to be used for PCIE3.0 and
PCIE4.0 respectively

= Supports only Command Line Interface (CLI) for SigTest

= Supports only SCPI commands to remotely communicate with the
TekExpress application
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Automates compliance measurements for PCI Express 3.0 BASE
Specification Rev 0.9. for PCIE_3 8GB_BASE

Automates compliance measurements for PCI Express 4.0 BASE
Specification Rev 0.9. for PCIE 4 16GB_BASE

Features of previous release

Support U.2 (SFF-8639) specification, provided the machine has SigTest
v3.2.0 with U.2 templates

Clock lane support in differential mode for the System-Board device type of
CEM specification and Host device type of U.2 (SFF-8639) specification

Updated mask co-ordinates for the Add-in-card device type of CEM
specification, of Gen2 in DLL mode

RF Switch support to test the x12 and x16 lanes using Keithley and
Gigatronics switches respectively

Trigger type support for Gen3 (Auto/Width/Edge)

Supports P75xx, P76xx, and P77xx Trimode probes

TekExpress setup files in-line with PCI-SIG Compliance Workshop
Faster test execution time with improved Autoset

Simple push button, enabling the users to manually toggle PCle presets from
AWG/AFG

Automates compliance measurements for PCI Express 3.0 CEM
Specification Rev 0.9. for the following configurations:

= PCIE 1 0a- PCIEX TX ADD CON 250Ul
= PCIE 1 0a- PCIEX TX SYS CON 250Ul
= PCIE CEM CARD 1 |

= PCIE CEM SYS 1 1

= PCIE 2 0 CARD

= PCIE 2 0 SYS

= PCIE 3 0 CARD

= PCIE 3 0 SYS

Fully automated General, Jitter, Composite Eye, Transition Eye, and Non
Transition Eye measurements

Provides both an automation solution (for compliance) and DPOJET (for
debug)

The PCI-SIG” PCI Express Compliance Test Library is integrated into the
TekExpress framework

Reduces the time required to conduct testing

Minimizes user intervention when conducting time-consuming testing
Enables loading filter files to support system and add-in card measurements
Performs fully-automated testing for system and add-in card measurements

Provides individual or group test selection by using a tree-structure menu
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®  Built-in reporting features:
= Provides a Pass/Fail summary table
m  Provides margin details on each test
= Provides a consolidated report for all tests

m  Complete programmatic interface enables automation scripts to call PCle
functions

TekExpress PCI Express Tx Compliance and Testing Solution Help vii
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Getting help and support

Related documentation

The following manuals are available as part of the TekExpress PCle Compliance
and Debug Solution documentation set.

Table 1: Product documentation

Item Purpose Location

Application Help In-depth operation and Ul help

PDF of the Application Help Printable version of the
compiled Application help

Seealso . . al support

TekExpress PCI Express Tx Compliance and Testing Solution Help 1
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Conventions used in help

Application Help uses the following conventions:
®m  The term “DUT” is an abbreviation for Device Under Test.

= The term “select” is a generic term that applies to the two methods of
choosing an option: using a mouse or using the touch screen.

= The term "close" refers to normally close the relay signal (select the signal).

= The term "open" refers to normally open the relay signal (unselect the
signal).

m  The term "channel" refers to the relay signal or oscilloscope channel.

Technical support

Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope. Contact Tektronix through mail, telephone, or the Web site. See
Contacting Tektronix for more information.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):

General information All instrument model numbers

m Hardware options, if any
= Probes used
®  Your name, company, mailing address, phone number, FAX number

m  Please indicate if you would like to be contacted by Tektronix about your
suggestion or comments.

Application specific Software version number

information

Description of the problem such that technical support can duplicate the
problem

m  If possible, save the setup files for all the instruments used and the
application

m  Ifpossible, save the TekExpress setup files, log.xml, *.TekX (session files
and folders), and status messages text file

m Ifpossible, save the waveform on which you are performing the
measurement as a .wfm file

2 TekExpress PCI Express Tx Compliance and Testing Solution Help



Getting started

Minimum system requirements

The following table shows the minimum system requirements needed for an
oscilloscope to run TekExpress PCI Express.

Table 2: System requirements

Component

Requirement

Oscilloscope

See Instruments and accessories required

Processor

Same as the oscilloscope

Operating system

Microsoft Windows 7 (64-bit only) Required Windows 7 user
account settings

Memory

Same as the oscilloscope

Hard disk

Same as the oscilloscope

Display

Same as the oscilloscope

Firmware

Tekscope 10.7.0 or later for MSO/DSA/DPO70000C, D, DX, SX

Software

DPOJET, Jitter and Eye Diagram Analysis Tool 2
Microsoft .NET 4.0 Framework

Microsoft Internet Explorer 8.0 SP1 or later
PyVisa version 1.0.0

IronPython version 2.7.3

Microsoft Photo Editor 3.0 or equivalent software for viewing
image files

Adobe Reader 7.0 or equivalent software for viewing
portable document format (PDF) files

1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, a sampling oscilloscope), it is recommended that
you connect a secondary monitor, which must be enabled before launching the application.
2 For software version, refer to Readme TekExpress PCI Express.txt file at C:\Program Files\Tektronix\TekExpress\TekExpress PCI Express

TekExpress PCI Express Tx Compliance and Testing Solution Help 3
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Instruments and accessories required

The following table lists the instruments and accessories required for TekExpress
PCI Express application.

Table 3: Instruments and accessories required for PCI Express application

Instrument/Accessory Model number

Oscilloscope MS070604 3, DPO/MSO70604C (Gen1 testing only)
MS070804%, DPO/MSO70804C (Gen1 and Gen2 testing only)
MS071254%, DPO/MS071254C (Gen1, Gen2, and Gen3
testing)

MS0716043, DPO/MSO71604C (Gen1, Gen2, and Gen3
testing)

MS0720043, DPO/MSO72004C (Gen1, Gen2, and Gen3
testing)

DPO/DSAT72504D ( Gen 1, Gen2, and Gen 3 testing)
DPO/DSA73304D (Gen 1, Gen 2, and Gen 3 testing)
DPO/MS072304DX (Gen1, Gen2, and Gen3 testing)
DPO/MS072504DX (Gen1, Gen2 and Gen3 testing)
DPO/MS073304DX (Gen1, Gen2 and Gen3 testing)
DPO72304SX (Gen1, Gen2 and Gen3 testing)

DPO75002SX [Standalone * or 2 stack] (Gen1, Gen2 and Gen3
testing)

DPO73304SX (Gen1, Gen2 and Gen3 testing)

DP075902SX [Standalone? or 2 stack] (Gen1, Gen2 and Gen3
testing)

DPO77002SX [Standalone? or 2 stack] (Gen1, Gen2 and Gen3
testing)

Arbitrary Function Generator | Tektronix AFG3252, AFG3252C
(AFG) 5 (for automatic test
pattern toggling)

gw&r{fgiﬁiifﬂﬁffe”ﬁat"r = Tektronix AWG5002B/C, AWG5012B/C, AWG5014B/C

pattern toggling) = Tekironix AWG7082B/C, AWG7122B/C
= Tektronix AWG70001A, AWG70002A

Probes P7313, P7513, P7513A, P7516, P7520A (with P75PST tip),
P7520A, P7633, P7720, P7716, P7713

3 Requires Microsoft Windows 7 (64-bit) operating system. Contact your local Tektronix Customer Service representative for upgrade information.
4 Standalone can be used only for CEM specification Add-In-Card device type or U.2(SFF8639) specification Module device type
5 The listed AFG/AWG instruments support both differential inputs (requires 2 channels) and 100 MHz burst mode.

4 TekExpress PCI Express Tx Compliance and Testing Solution Help
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Instrument/Accessory Model number
itoh 67
RF Switch = Keithley System S46 and S46T RF Microwave Switch
Systems for x12 PCle
= Gigatronics RF Switch 26GHz (8902-L-48TS26) for x16
PCle

Other devices = SMP-SMA cables

= TCA-SMA connectors
= Matched pair cables
= Tektronix P7313 SMA Differential Probe

Windows 7 user account settings

Windows 7 instruments need to have the User Account Control Settings set to
Never Notify. To set User Account Control Settings:

1. Go to Control Panel > User Accounts > Change User Account Control
settings.

2. Setit to Never Notify as shown in the image.

‘f:;‘ User Account Control Settings = 53

Choose when to be notified about changes to your computer

User Account Centrol helps prevent potentially harmful programs frem making changes to your computer.
Tell me more about User Account Control settings

Always notify

MNever notify me when:

® Programs try to install software or make changes to
my computer

® Imake changes to Windows settings

‘(:j‘ Mot recommended, Choose this only if you need to
use programs that are not certified for Windows 7
- because they do not support User Account Contral,

Never notify

6 Use GPIB cable or USB-to-GPIB cable to connect the oscilloscope to switch.
7 The GPIB address of the RF Switch and toggle instrument (AWG/AFG) must be different.

TekExpress PCI Express Tx Compliance and Testing Solution Help 5
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See also

Install the software

Supported oscilloscopes

Use the following steps to install PCI Express software on any compatible
instrument running Microsoft Windows 7 (64-bit). See Minimum System
Requirements for details.

1.
2.

Close all applications (including the TekScope application).

Go to the www.tek.com Web site and search for TekExpress PCI Express to
locate the installation file. Download the file
TekExpress PCle Deployment Package.exe.

Copy or download the PCle installer file to the oscilloscope.

Double-click the installer .exe file to extract the installation files and launch
the InstallShield Wizard. Follow the on-screen instructions. The software
installs in the following location:

C:\Program Files\Tektronix\TekExpress\TekExpress PCI Express

The installer updates the TekScope Analyze menu to include the installed
options.

Search...

Mark...

Jitter and Eye Analysis (DPOJET) *
Results Table

Serial Error Detector

UZB2.0 Test Package

Serial Data Link Analysis

TekExpress PCl Express

TekExpress PCI Express Tx Compliance and Testing Solution Help
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See also . ,
Minimum system requirements

Supported oscilloscopes

Set application file permissions

Before you run tests for the first time, do the following:

1. Understand where your test files are stored on the instrument.

After you install and launch TekExpress PCle, it creates the following folders on
the oscilloscope:

= \My Documents\My TekExpress\PCI Express
= \My Documents\My TekExpress\PCI Express\Untitled Session

Every time you launch TekExpress PCle, an Untitled Session folder is created in
the PCle folder. The Untitled Session folder is automatically deleted when you
exit the PCle application. To preserve your test session files, save the test setup
before exiting the TekExpress application.

A CAUTION.

Do not modify any of the session files or folders because this may result in loss of
data or corrupted session files. Each session has multiple files associated with it.
When you save a session, a .TekX file, and a folder named for the session that
contains associated files, is created on the oscilloscope X: drive.

2. Map the shared My TekExpress folder as X: (X drive) on the instruments
used in test setups running Microsoft Windows Operating System.

The My TekExpress folder has the share name format <domain><user
ID>My TekExpress. Or, if the instrument is not connected to a domain, the
share name format is <instrument name><user ID>My TekExpress. This
shared folder is used to save the waveform files and is used during other file
transfer operations.

NOTE. If the X: drive is mapped to any other shared folder, the application
will display a warning message asking you to disconnect the X: drive
manually.

3. Make sure that the My TekExpress folder (Drive X:) has read and write
access:

Right-click the folder and select Properties.
b. Select the General tab and then click Advanced.

c¢. Inthe Advanced Attributes dialog box, make sure that the option
Encrypt contents to secure data is NOT selected (not checked).
Example.

TekExpress PCI Express Tx Compliance and Testing Solution Help 7
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| My TekExpress Properties E3

General | Sharing I Security I Previous Wersions Customize|

Advanced Attributes 24

E: Choose the settings wou wank For this Folder,
When wou click O or Apply on the Properties dialog, vou will be
asked if you want the changes to affect all subfolders and files
as well,
Archive and Index attributes
[TIFalder is ready For archiving

Allaw Files in this folder to have contents indexed in addition to file
properties

Compress or Encrypt attributes
Compress contents to save disk space
crypt contents ko secure data Dekails

’ oK ] [ Cancel

[ K H Cancel ] Apply

4. See the prerun checklist before you run a test.

See also .
Configuration test parameters

View test-related files
Application directories and usage

File name extensions

8 TekExpress PCI Express Tx Compliance and Testing Solution Help
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Activate the license

Activate the license using the Option Installation wizard on the oscilloscope.
Instructions for using the Options Installation window to activate licenses for
installed applications is provided in the oscilloscope online Help:

1. From the oscilloscope menu bar, click Utilities > Option Installation.
The TekScope Option Installation wizard opens.

2. Push the F1 key on the oscilloscope keyboard to open the Option Installation
help topic. Follow the directions in the topic to activate the license.

See also , . . . .
View version and license information

View software version and license information

Use the following instructions to view version information for the application and
for the application modules such as the Programmatic Interface and the
Programmatic Interface Client.

To view version information for PCle:

1. In the PCle application, click the Options button and select About
TekExpress.

The About Tektronix TekExpress PCI Express dialog box appears, showing
the version details.

gﬁ About Tektronix TekExpress PC| Express

TekExpress’

Automated Solutions

To view license and option key information:

1. From the TekScope menu, select Help > About TekScope.
2. Scroll through the Options section list to locate PCI Express.
3. To view the Option key, look below the Options list.
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See also Activate the license

Options menu

Application directories and their contents

TekExpress PCle  The TekExpress PCle application files are installed at C:\Program Files
application  \Tektronix\TekExpress\TekExpress PCI Express.

It contains the following folders:

Mame

. Bin

. Compliance Suites
. Documents

| Examples

, ICP

, Images

. Lib

. Report Generator
| Setup Files

) Tools

The following table lists the application directory names and their purpose.

Table 4: Application directories and usage

Directory names Usage

ACP Contains instrument and PCle application-specific interface
libraries

Bin Contains miscellaneous PCle application libraries

Compliance Suites Contains compliance-specific files

Data Manager Contains result management-specific libraries of the PCle
application

Data Storage Contains libraries needed for storing data

Documents Contains the technical documentation for the PCle application

Examples Contains various support files and example Python and C# test
files

ICP Contains instrument and PCle application-specific interface
libraries

Lib Contains utility files specific to the PCle application and Switch
Matrix filter files

10 TekExpress PCI Express Tx Compliance and Testing Solution Help
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Directory names

Usage

Report Generator

Contains style sheets for report generation

Setup files

Contains PCI-SIG work shop compliant TekExpress setup files
for System-Bard, Add-In-Card of CEM specification and Host,
Module of U.2(SFF8639) specification

Tools

Contains instrument and PCle application-specific files

See also .
View test-related files

File name extensions

File name extensions

The TekExpress PCle application uses the following file name extensions:

File name extension Description

.TekX Application session files (the extensions may not be displayed)

.py Python test file. See the TekExpress PCI Express\Examples
folder for a sample file

xml Test-specific configuration information (encrypted) file
Application log file

wfm Test waveform file

.mht Test result reports (default). Test reports can also be saved in
HTML format

fit Filter files

.chm, pdf Help manuals

Waveform file names

This application uses file name conventions to access the Data and Clock

waveforms. It is recommended to save the waveforms with following file names.
m Differential data waveform:Tek PCle 01 8Gbps Ln00 PO _d Diff-wfm
= Differential clock waveform: Tek PCle 01 8Gbps Ln00CIlk PO d Diff-wfm

m  Single ended data positive waveform:
Tek PCle 01 8Gbps Ln00 PO _d Pos.wfin

= Single ended data negative waveform:
Tek PCle 01 8Gbps Ln00 PO d Neg.wfm

m  Others:

Tek PCle _Slot DataRate LaneNumber PresetNumber Data_ Differential.w

fm

TekExpress PCI Express Tx Compliance and Testing Solution Help 11
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See also Select report options

View test-related files
Application directories and their contents

Before you click start
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Run the application

See also

To launch the PCle application, do either of the following:
= Select Analyze > TekExpress PCI Express from the TekScope menu.
= Double-click any saved PCle session file (<file name>.TekX).

When you first run the application after installation, the application checks for a
file called Resources.xml located at C:\Users\<username>\My TekExpress\PCI
Express. The Resources.xml file gets mapped to the X: drive when the
application launches. Session files are then stored inside the X:\PCI Express
folder.

The Resources.xml file contains information about available network-connected
instruments. If this file is not found, the application runs an instrument discovery
program, before launching PCle, to locate available instruments.

To keep the application window on top, select Keep On Top from the PCle
Options menu. If the application goes behind the oscilloscope application, click
Analyze > TekExpress PCI Express to move the application to be in front.

Activate the license
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Exit the application

Use the following method to exit the application:

NOTE. Using other methods to exit the application results in abnormal
termination of the application.

1.

Click on the application title bar.

2. Do one of the following:

= Ifyou have an unsaved session or test setup, you are asked to save it
before exiting. To save it, click Yes. Otherwise click No. The application
closes.

= A message box appears asking if you really want to exit TekExpress. To
exit, click Yes.

NOTE. To minimise the application, clickm on the application title bar.

Application controls and menus

14

Application controls  Table 5: Application controls descriptions

Iltem

Description

Options menu

Menu to display global application controls

Panel buttons

E

Controls that open panels for configuring test settings and
options.
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Item

Description

Start/Stop button

Start

Use the Start button to start the test run of the measurements in
the selected order. If prior acquired measurements have not
been cleared, the new measurements are added to the existing
set.

The button toggles to the Stop mode while tests are running. Use
the Stop button to abort the test.

Pause \ Continue button

Pause

Continue

"y

Use the Pause button to temporarily interrupt the current
acquisition. When a test is paused, the button name changes to
“Continue.”

Clear button

Clear

Use the Clear button to clear all existing measurement results.
Adding or deleting a measurement, or changing a configuration
parameter of an existing measurement, also clears
measurements. This is to prevent the accumulation of
measurement statistics or sets of statistics that are not coherent.
This button is available only on the Results pane.

Minimize button

&

Minimizes the application.

Close button

Exits the application.
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Item Description

Application window move Place the cursor over the application window and drag it to the
desired location.

Mini view Toggles the application to mini view which displays all the run
messages with the time stamp, progress bar, Start / Stop button,
and Pause / Continue button.

The application will navigate to mini view when you start the test
run of the measurements.

[~ TekExpress PCI Exp [+])

Initializing run time environment. This might take some time
02/28/17 09:36:12 - Reading Setup ifformation
02/28/17 09:36:12 - Selected Data ratels) are - 2.5 Gops.5 Gbps 8Gbps

02/28/17 03:36:12 - Highest generation supported on ths scape DPO72504D is Gen

Running... |
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Options menu

Options menu overview. The Options menu is located in the upper right corner of

the application.

The Options menu has the following selections:

Menu Function

Default Test Setup Opens an untitled test setup with defaults
selected

Open Test Setup Opens a saved test setup

Save Test Setup ?aves the current test setup selections

Save Test Setup As Creates a new test setup based on an existing

one
1

Open Recent

Displays a menu of recently opened test setups
to select from

Instrument Control Settings

Shows the list of instruments connected to the
test setup and allows you to locate and refresh
connections to those instruments

Keep On Top Keeps the TekExpress PCle utility on top of
other open windows on the desktop

Email Settings Use to configure email options for test run and
results notifications

Deskew Allows to read the skew and attenuation values
from the TekScope application. Before using this
option, manually compensate for skew and
attenuations in Tekscope application.

Help Displays the TekExpress PCle Online help

About TekExpress

= Displays application details such as
software name, version number, and
copyright

= Provides access to license information for
your PCle installation

= Provides a link to the Tektronix Web site

TekExpress PCI Express Tx Compliance and Testing Solution Help
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Options menu

Default Test Setup

Open Test Setup

Save Test Setup

Save Test Setup As

Open Recent »

Instrument Control Settings
Keep On Top
Email Settings

Deskew

Help
About TekExpress

See also.

Application controls
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Instrument control settings dialog box. Use the TekExpress Instrument Control
Settings dialog box to search for and list the connected resources (instruments)
found on specified connections (LAN, GPIB, USB, and so on) and each
instruments connection information. You access this dialog box from the Options
menu.

Access this dialog box from the Options menu.

_TekExpress Instrument Control Se

October 05. 2011 13:43:41

Use the Instrument Control Settings feature to search for connected instruments
and view instrument connection details. Connected instruments displayed here
can be selected for use under Global Settings in the test configuration section.

See also.

Options menu overview
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View connected instruments. Use the Instrument Control Settings dialog box to
view or search for connected instruments required for the tests. The application
uses TekVISA to discover the connected instruments.

To refresh the list of connected instruments:
1. From the Options menu, select Instrument Control Settings.

2. Inthe Search Criteria section of the Instrument Control Settings dialog box,
select the connection types of the instruments for which to search.

Instrument search is based on the VISA layer, but different connections
determine the resource type, such as LAN, GPIB, and USB. For example, if
you choose LAN, the search will include all the instruments supported by
TekExpress that are communicating over the LAN. If the search does not find
any instruments that match a selected resource type, a message appears
telling you that no such instruments were found.

3. Click Refresh. TekExpress searches for connected instruments.

4. After discovery, the dialog box lists the instrument-related details based on
the search criteria you selected. For example, if you selected LAN and GPIB
as the search criteria, the application checks for the availability of
instruments over LAN, then GPIB.

L]
' TekExpress Instrument Control Setting

»|ISA-GFIB WE07 0604 CHRODDT
DFO5204 FRO00008
DFO733040C CHARDS
00029100 2300002
DFO7OBO04 Fa204

May 16, 2011 17:49:47 s J

The details of the instruments are displayed in the Retrieved Instruments table.
The time and date of instrument refresh is displayed in the Last Updated field.

See also.

Configuration test parameters
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Equipment connection setup

Email settings. Use the Email Settings utility to configure email notifications to
receive notifications when a test completes, produces an error, or fails. Select the
type of test session information to include with the email, such as test reports and
test logs, the email message format, and the email message size limit.

Access this dialog box from the Options menu.

NOTE. Recipient email address, sender’s address, and SMTP Server are
mandatory fields.

See also.

Configure email settings
Options menu

Select test notification preferences
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Configure email settings. To be notified by email when a test completes, fails, or
produces an error, configure the email settings.

1. Options > Email Settings to open the Email Settings dialog box.

2. (Required) For Recipient email Address(es), enter one or more email
addresses to which to send the test notification. To include multiple
addresses, separate the addresses with commas.

3. (Required) For Sender’s Address, enter the email address used by the
instrument. This address consists of the instrument name followed by an
underscore followed by the instrument serial number, then the @ symbol and
the email server used. For example:
DPO72016C_B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server
address of the Mail server configured at the client location, and the SMTP
Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name,
password, and host name in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not
be saved and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:
= Reports: Select to receive the test report with the notification email.

= Status Log: Select to receive the test status log with the notification
email. If you select this option, then also select whether you want to
receive the full log or just the last 20 lines.

6. In the Email Configuration section:
= Select the message file format to send: HTML (the default) or plain text.

®m  Enter a maximum file size for the email message. Messages with
attachments larger than this limit will not be sent. The default is 5 MB.

= Enter the number in the Number of Attempts to Send field, to limit the
number of attempts that the system makes to send a notification. The
default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use
this check box to quickly enable or disable email notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.
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Email settings

Application panels

Application panel  Panels group related configuration, test selection, and results settings. Click a
overview button to open the associated panel.

A panel may have one or more tabs that list the selections available in that panel.
Controls in a panel can change depending on settings made in that panel or
another panel.

The TekExpress PCle panels are:
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Table 6: Application panels

Panel Name Purpose

Setup The Setup panel shows the test setup controls. Click the Setup
button to open this panel.
Use this panel to:

= Select DUTparameters.

= Select the test(s).

= Set acquisitions parameters for selected tests.
= Configuration test parameters

= Select test notification preferences.

Status View the progress and analysis status of the selected tests, and
view test logs.

Results View a summary of test results and select result viewing
preferences.

Reports Browse for reports, save reports as specific file types, specify

report naming conventions, select report content to include (such
as summary information, detailed information, user comments,
setup configuration, application configuration), and select report
viewing options.

See also.
Application controls

About setting up test
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Setup panel Setup panel overview. The Setup panel contains sequentially ordered tabs that
help guide you through a typical test setup process.

DUTID [DUT001 [(®  siothumoer 01

@ Acquire live waveforms O Use pre-recorded waveform files

Sitestods Compiarce |

Specification Device Type ersion
BaseSpec ‘ v | |TX Test Board | v | ‘Gend -4.0 ‘ v |

Device Profile

DataRates T

3 Ghls Selected Presets for Signal Quality
P0.P01.PD2 P0O2.P04.POS POS.PO7.POS PO2.P10

Selected Presets for Signal Quality
e i F0.F01,FO2 FO2, P04, FOS FOE,FOT FOS, FOS.F10
S5C Ieas Limits
ol el sew.
Mult-Lane [ Automated DUT Control i
Signal Validation
|Promp1 me if Signal Check Fails ‘ v |

n Use Switch Matrix r Perform Pattern Decoding

Use the tabs on this panel to:
Set the DUT parameters
Select test(s)

Select acquisition parameters
Set configuration parameters

Select test notification preferences

TekExpress PCI Express Tx Compliance and Testing Solution Help
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Set DUT parameters. Use the DUT tab to select parameters for the device under
test. The settings are global and apply to all tests for the current session. DUT
settings also affect the list of available tests in the Test Selection tab.

Click Setup > DUT to access the DUT parameters.

_ﬂ TekExpress PCI 4. o5 n @ ee

DUTID [DUTOD1

| G Slot Number 01

= Acquire live waveforms

Use pre-recorded waveform files

Sitestods Compiarce |

Specification

Device Type Version

|BaseSpec ‘ v |

[TX TestBoard |¥ |  [Gend-40 |v|

Device Profile

DataRates  Transmitter Equalization LinkAnalysis

Selected Presets for Signal Quality
8be5 P0.P01.P02 P03.P04,PO5 POE.POT.POS. PO2.P10

Selected Presets for Signal Quality
166“‘[5 P0.,F01,P02 P03,P04,FO5 FOS, P07 FOS POS.P10

85C

+) On Off

Multi-Lane

Selected Lanes é

Lo

Meas Limits

[ Automated DUT Control @

Signal Validation
|Promp1 me if Signal Check Fails ‘ v |

n LepamEnliams é [ Perform Pattern Decoding

Table 7: DUT tab settings

Setting Description

DUTID Adds an optional text label for the DUT to
reports. The default value is DUT001.
1

Slot Number The slot parameter (1, 2, 4, 8,16, or 32) of the

DUT.

@ Comments icon (to the right of the DUT
ID field)

Opens a Comments dialog box in which to enter
optional text to add to a report. The maximum
number of characters is 256. To enable or
disable comments appearing on the test report,
see Select report options.)

Acquire live waveforms

Acquire active signals from the DUT for testing.

Use prerecorded waveform files

Run tests on a saved waveform. Open (load) a
saved test setup

1" In pre-recorded mode, waveform recall will not be successful if the session name is lengthy, i.e. more than 10 characters.
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Setting

Description

SigTest Mode

Sets the overall testing mode. Select
Compliance or User Defined:

= Compliance: Preselects tests and
parameters to meet compliance
specifications for the selected version,
specification, and device type.

= User Defined: Enables the user to select
specific tests and set custom parameters
for tests.

Specification

PCle supports the CEM, BaseSpec, and U.
2 (SFF-8639) specification.

NOTE. U.2 (SFF8639) and Base Specification
supports Gen3 (3.0) version only.

Device Type

Sets the DUT device type (System-Board or
Add-in-Card).

Sets the DUT device type. The device type
available depends on the selected specification.
For CEM, the Device Type is System-Board or
Add-In-Card

For BaseSpec, the Device Type is TX Test
Board

For U.2 (SFF-8639), the Device Type is Module
or Host

Version

Sets the DUT generation version. Available
versions are Gen 1 (1.0a and 1.1), Gen2 (2.0),
Gen3 (3.0), and Gen4 (4.0)

Device Profile

Data Rates

Sets the data rates to test (2.5 Gb/s, 5 Gb/s,
8 Gbls, and 16 Gb/s). The data rates available
depend on the selected DUT version.

Transmitter Equalization

Sets transmitter preemphasis levels. Available
for Gen 2 and Gen 3 devices.

The application selects both preemphasis levels
by default when in the compliance mode for an
Add-in-Card.

At least one preemphasis level must be
selected.

Link Analysis Opens the Link Analysis dialog box to select
custom filter files with which to perform link
analysis on the source waveforms. Link Analysis
dialog box

Presets Opens the Presets dialog box to select the

presets (P0-P10) used to perform the signal
quality tests. Only available for Gen 3 DUT
version.

TekExpress PCI Express Tx Compliance and Testing Solution Help
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Setting

Description

Meas Limits

Voltage Swing Limits

Sets the lane/link transmitter p-p voltage swing.
This affects the limits applied to certain
measurements based on the settings and does
not change anything on the DUT tab.

Crosstalk Limits

Sets specific eye test limits depending on if the
DUT design uses interleaved or non interleaved
routing.

This affects the limits applied to certain
measurements based on the settings and does
not change anything on the DUT tab. This is
applicable for Gen2.

= When the DUT uses noninterleaved
routing, select Crosstalk (noninterleaved
routing).

= When the DUT uses interleaved routing,
select No Crosstalk (interleaved routing).

SSC (spread spectrum clocking)

Enables or disables SSC clocking.

This affects the limits applied to certain
measurements based on the settings and does
not change anything on the DUT tab.

Lanes

Opens the Test Lane Setup dialog box to select
the lanes to test. Lanes required for compliance
testing are colored orange. At least one lane
must be selected.

The Link Width setting determines the number of
lanes that can be tested.

Test Lane Setup dialog box

Automated DUT Control

Enables automatic toggling of the DUT into
different test modes (generation/equalization).
Requires the use of an AFG or AWG instrument.
Click Setup to access the Automated DUT
Control dialog box

Use Switch Matrix

Select to use the switch matrix. This solution
allows you to map each of the several
transmitter signals and forward the selected
input either to another relay or to the
oscilloscope channel.

Click Setup to configure the switch matrix. Refer
Switch Matrix application for more details on
configurations.

NOTE. Keithley supports maximum of 12 lanes
and Gigatronics supports maximum of 16 lanes.

Signal validation

Sets the application to validate acquisition
signals and perform the specified action to take
when acquired signals do not meet
requirements. Select the action from the list.

28
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Setting Description

Perform Pattern Decoding Select to validate the pattern according to the
respective lane and preset for Gen3 and Gen4.

See also.
About setting up tests

Select a test

Link analysis dialog box. The Link Analysis dialog box lets you select custom
filter files for performing link analysis on the source waveforms. The options
available depends on the Specification selected.

De-Embed

Select de-embed for the data rate; click Browse and select the de-embed filter
file.

Embed

Select Embed and select SigTest or Scope from the drop-down list. Scope option
allows you to select the scope filter file.

SigTestEqualization

Select SigTestEqualization and select Optimize or Fixed from the drop-down list.
Fixed mode allows you to set the CTLE Index and DFE Tap Value parameters.

TekExpress PCI Express Tx Compliance and Testing Solution Help 29



Operating basics

30

Test lane setup dialog box. The Test Lane Setup dialog box enables setting the
link width and specific lanes to test. Lanes required for compliance testing are
colored orange. At least one lane must be selected.

16 Lones ||

(T

= The Link Width parameter sets the lanes that are tested.

®=  The lanes required for compliance testing are selected by default.
= Click Select All to select all the lanes.

= Click Deselect All to clear the selected lanes.

= Click Compliance Lanes to set all lanes required for compliance testing for
the specified link width value.

TekExpress PCI Express Tx Compliance and Testing Solution Help



Operating basics

Automated DUT control setup. The Automated DUT Control dialog box sets the
parameters needed for automatic toggling of the DUT into different test modes

(generation/equalization). DUT automation requires the use of a signal source
(AFG or AWG).

Automated DUT Control
2560ps ||

Use Default Settings n
sne v

Initial State of DUT: Sets the starting state of the DUT.

Initial State of Signal Source: Sets the AFG/AWG state to On (default) or Off.
The On state enables the AFG/AWG output before the application starts signal
acquisition. Some DUTs will toggle to the next signal state when the AFG/AWG
initial state is On. Set the initial state to Off for these types of DUTs before
running automated tests.

Toggle from Gen3 P10 to Genl: Sets the DUT to toggle automatically to Genl
after Gen3 P10 test execution.

Automation Settings: The Automation Settings values are Use Default Settings,
Manually Configure Settings, and Custom Settings:

= Use Default Settings: The signal source parameters are set to predefined
values as recommended by the test specification. The signal source parameter
fields are disabled and cannot be edited.

= Manually Configure Settings: The signal source parameters are set directly
at the AFG or AWG. The signal source parameter fields are disabled and
cannot be edited. The PCle application turns on or off the signal source
without changing the settings.

= Use Custom Settings: The signal source parameters are set to the values
specified in the Signal Source Parameters area. The signal source parameter
fields are enabled.

Signal Type: Valid signal types are Sine and Square.
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Frequency, Amplitude: Sets the AFG to output the specified frequency and
amplitude values.

Burst Count: Sets the AFG to output the specified signal burst count.

NOTE. Ch 1 and Ch 2 on the AFG source are set to 180° phase difference in all
modes except Manually Configure Settings.

NOTE. Using DC Caps or Manual toggle, you can eliminate the automatic
toggling issues that is due to DC offset.

Select tests. Use the Test Selection tab to select the Signal Test and Preset
Test(s) (for Gen3 only).

NOTE. All tests are selected by default.

1. Click Setup > Test Selection.
2. Select the test(s) to run:

m  Click + to expand a group of commands. Click the check box adjacent to
a test group to select all tests in that group. Click check boxes adjacent to
individual tests to select those tests.

®=  Click Deselect All button to deselect all tests. All tests are selected by
default.

m  Click Select All button to select all tests.

= Click Show MOI button to open the MOI (Methods of Implementation)
document for all measurements.

®  Click Schematic button to view a diagram that shows the correct DUT
and equipment setup for the selected test. Use to verify your test
equipment setup before running the test.

3. For Gen3 testing:
= (Gen3 only) Click the Preset Test tab and select the presets tests.

®m  (Gen3 only) Click the Lanes button in the Preset Test tab to view and
select which lanes to use for preset testing. At least one lane must be
selected.

See also.
Set acquisition parameters

About setting up tests

Acquisitions tab.
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Set acquisition parameters. Use the Acquisition tab in the Setup panel to view
and select test acquisition parameters, including the signal source channels,
acquisition options, and waveform save options. This panel also shows the signal
inputs required for the selected DUT parameters.

Contents displayed on this tab depend on whether you acquire active waveforms
or use prerecorded waveform files (as set in the DUT tab. Contents displayed on
this tab also depend on detected probes and the specified DUT type.

Active waveforms.

Figure 1: Acquisitions tab: using active waveforms

TekExpress PCI Ex
v

CEM : System-Board : Gen3 -3.0

|Lane

Source |

CH1 Clock+
Clock-

CH3
CH4

Acquisition

Lane0

Lane0

Lanel:
Lanel:

Lane0:
Lane0 :
Lane0:
1 8Ghbps P03 Acquisition
Lane0:
Lane0:
Lane0:
Lane0 :

2.5Gbps Acguisition
5Gbps 3.5dB Acquisition

. BGbps 6dB Acquisition

8Gbps PO Acquisition
8Gbps P01 Acquisition
8Gbps P02 Acquisition

8Gbps P04 Acquisition
8Gbps P05 Acquisition
8Gbps P06 Acquisition
8Gbps PO7 Acquisition

—————————————————————
aA::quire Options a
= Acquire All Waveforms Before Analysis
Acquire and Analyze Acquisition in Seguence
Acquire Only - Do Not Analyze
Save Options

Save Only Analyzed Waveform

m  Click the Source fields to select signal sources for the listed lanes. The
number of lanes shown depends on the parameters set in the DUT tab.

m  Click Refresh Sources to refresh the probe configuration after changing any
probes. (This button performs the same function as the Refresh button in the
Probe Configuration dialog box.)
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= Click View Probes to view the detected probe configuration. Use the View
Probes dialog box to enable or disable probe signal source access in the
application.

Probe Configuration

|g Source Probe Type Probe Method
[w] CHL Diff Probe Differential

] CHZ Trimode Probe Differential %]

[w] CH3 Diff Probe Differential

[+ CH4 TCA SMA

Only Differential option is available under Probe Method for Trimode
probes.

m  Click the Acquire Options controls to set how the application acquires and
analyzes signals.

m  Click the Save Options field to set how the application saves acquired
waveforms (save all waveforms, save all waveforms after applying filters, or
discard all waveforms after running analysis).

Prerecorded waveforms.

Figure 2: Acquisitions tab: using prerecorded waveforms

CEM : Add-In-Card - Gen3 - 3.0
Acquisttion | WaveForm FileName |
Laned : 5Gbps 3.5dB Acquisition ﬂ FAALL_REF_WMFS\PCIE_Tx_Ref_\
_Laneo:SGbps 6dB Acquisition (%) \
o Replace Waveform File

@ Acquisitions Remove Waveform File

Select Waveform Files

When using prerecorded waveform files, this panel lists available prerecorded
waveform files. You can only select the source of the prerecorded waveform file
for each test. See Set acquisition waveform source for prerecorded waveform

files.
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Set acquisition options. Select an Acquire Option to set the order in which
waveforms are acquired and analyzed:

= Acquire All Waveforms Before Analysis: Acquire all waveforms required
by tests before performing analysis. All required user interventions (such as
connecting to different lanes) are completed, and waveforms acquired, before
the analysis is run. You can turn off the DUT after the acquisitions are
completed.

= Acquire and Analyze Acquisition in Sequence: Acquire waveforms and
analyze for each test before proceeding to the next test. Use this setting to
stop the testing when an error occurs, investigate and correct DUT,
instrumentation connections, or application settings, then restart testing.

= Acquire Only — Do Not Analyze: Acquire all waveforms required by tests,
and then stop (do not use waveforms to perform test analysis). Use this
setting for testing multiple DUTs once the test and application settings are
correct. Acquire all required waveforms and save the session for each DUT,
and then recall the waveforms at a later point to analyze in Prerecorded
mode.

See also.
Set acquisitions signal source

Set acquisition waveform save options
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Set acquisition waveform save options. Select a Save Option to set how to save
acquired test waveforms:

= Save All the Waveforms: Save all waveforms that were acquired for tests.
= Save Only Analyzed Wfms: Save waveforms that was used for analysis.

= No Waveforms Saved — Discard after analysis: Delete all acquired
waveform data after analysis is complete.

Waveforms are saved to a folder that is unique to each session (a session starts
when you click the Start button). The folder path is X:\PCI Express\Untitled
Session\<dutid>\<date> <time>. Images created for each analysis, CSV files
with result values, reports, and other information specific to that particular
execution are also saved in this folder. When the session is saved, content is
moved to that session folder and the “Untitled Session” gets replaced by the
session name.

Waveform file names. This application uses file name conventions to access the
Data and Clock waveforms. It is recommended to save the waveforms with
following file names.

m Differential data waveform:Tek PCle 01 8Gbps Ln00 PO _d Diff-wfm
m Differential clock waveform: Tek PCle 01 8Gbps Ln00CIlk PO d Diffwfm

m  Single ended data positive waveform:
Tek PCle 01 8Gbps Ln00 PO _d Pos.wfm

m  Single ended data negative waveform:
Tek PCle 01 8Gbps Ln00 PO _d Neg.wfm

m  Others:
Tek PCle_Slot DataRate LaneNumber PresetNumber Data_Differential.w

fm
See also.
Set acquisitions signal source
Set acquisition waveform source for prerecorded waveform files

Set acquisition Acquire options
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Set acquisition waveform source for prerecorded waveform files. When using
prerecorded waveform files, there are no acquisition source selections to make.
You can only select the source of the prerecorded waveform files for each test.

ouT CEM : Add-In-Card : Gen3 - 3.0
Acquisition ‘WaveForm FileName
Lane0 : 5Gbps 3.5dB Acqguisition lgd FPALL_REF_WMFS\PCIE_Tx_Ref_\

¥|Lane0 : 5Gbps 648 Acquisition [Rmesis s aaimmimaie T ns
Replace Waveform File

IJ Acquisitions Remove Waveform File

Test Selection

Select Waveform Files
4 | Configuration

Preferences

If you selected to use a prerecorded waveform file (in the DUT tab), the lane and
source fields are not applicable and are not shown. The Acquisition tab instead
shows a table of the waveforms used for the required test acquisitions.

You can load a different waveform file for each table item. To load a different
waveform file:

L. Click the ellipsis button () of the waveform file to change.

2. Select the waveform task to perform (replace, remove, or select the
waveform file).

3. Use the dialog box to navigate to and select the waveform file with which to
replace the current file. You need to select all required differential waveforms
for analysis. For example, select one data waveform and one clock waveform
for each acquisition (except 2.5 Gbps) for testing a system board.

NOTE. Clock signals are not required for Genl (2.5 Gbps data rate) testing.

See also.
Set acquisition signal source
Set acquisition options

Set acquisition waveform save options
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Set acquisition signal source. Use this procedure to set the channel sources for
live waveform acquisitions. The number of Lane and Source fields shown
depends on the number of lanes selected for testing in the DUT tab.

1. Click Setup > Acquisitions.
2. Click in the Source column of the field to change.

3. Click the arrow button to list available sources from which to select.

CEM : System-Board : Gen3 - 3.0

Lanes:0
Lane Source Lane
Data1+ CH1 Clock+ 1
Catai- CH3 Clock- CH4
See also.

Set acquisition options
Set acquisition waveform save options

Set acquisition waveform source for prerecorded waveform files

Configure test parameters.
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About configuring test parameters. Use the Configuration tab to view and set
global and individual measurement parameters for the selected tests. Which fields
are available to edit depends on the selected Sigtest mode (Compliance or User
Defined) as set in this tab or the DUT tab.

NOTE. You cannot change test parameters that are grayed out.

SigTestMode (+) Compliance () User Defined

Global Settings

Instruments Detected

RF Switch Do not use

Real Time Scope DPO73304D { GPIBS:: 1:INSTR )
Signal Source for DUT Automation Do not use

[ Automated DUT Control i

Record Length Sample Rate
8Gbys 10 M 50 GS/s 16 GHz

16GHz |
16Gb/s 20 M 100 GS/s
Auto |

Sig Validation Threshold 200 my Trigger Type  Auto
IGen3)

SigTest Corfiguration
SigTest Exe Path |C:\Program Files (c86)\Sig Test 3.2.0\SigTest s
{Gen1,2,3)

SigTest Exe Path |C:\ngmm Files <86)\SigTest 4.0.30°\SigTest axe
(Gend)

See also.
Configuration tab parameters
About setting up tests

About running tests
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Configuration tab parameters. The following table lists the Configuration tab

settings and parameters.

Table 8: Configuration tab parameters

Parameter

Description

SigTest Mode

Determines whether test parameters are in
compliance or can be edited (User Defined
Mode).

= Compliance: Most test parameter values
cannot be edited.

= User Defined: Enables editing of most test
parameters.

Limits Editor

Shows the upper and lower limits for the
applicable measurement using different types of
comparisons.

In Compliance Mode, use the Limits Editor to
view the measurement high and low limits used
for selected tests.

In User Defined Mode, use the Limits Editor to
edit the limit settings.

Limits Editor )
View or Edit the values used for High Limit and Low Limit for each m
A blank cell means no limit value is applied

Test Name Details Datarate  CompareString  LowLimit Compare String .
Composit Eye Height Compost Eye Heigh... 2560ps  >= Greater ThanO... 34 B
[2 < 5 Ghps

Dj_dd

Dj_dd

Mask HitsCAll Bits)
al

To edit a value, click that field and either select
from the displayed list or enter a new value. Use
the bottom scroll bar to view all available fields.

Instruments Detected

Displays a list of the connected instruments
found during the instrument discovery.
Instrument types include equipment such as
oscilloscopes and signal generators.

Instrument Control

Click Settings to search for connected
instruments and view instrument connection
details. Connected instruments displayed here
can be selected for use under Global Settings in
the test configuration section.

Manual Toggle

Click Setup to manually toggle AWG or AFG for
PCle presets.

This is enabled when the Signal Source for DUT
Automation in Instruments Detected is selected.

Automated DUT Control

Enables automatic toggling of test patterns for
DUT tests. Requires an AFG instrument as part
of the test setup. Click Setup to configure the
DUT automation settings.
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Parameter

Description

Record Length, Sample Rate, Bandwidth

These settings apply to all tests selected for the
indicated data rate.

= Record Length: Specifies the waveform
record length.

= Sample Rate: Specifies the oscilloscope
sample rate to use for all tests.

= Bandwidth: Specifies the oscilloscope
bandwidth to use for all tests.

Sig Validation Threshold

Sets the threshold voltage to use for signal
validation.

Trigger Type (Gen3) = Edge
= Width
= Auto

SigTest Configuration Select the SigTest executable (.exe) for Gen1,
2, 3, and 4. Click Browse and select the .exe.
The default path is C:\Program Files
(x86)\SigTest x.x.x\ where x.x.x is the version
number of the SigTest.

See also.

About acquisition

De-embed using filter files

Set test notification preferences. Use the Preferences tab to set the application

action when a test measurement fails:

1. Click Setup > Preferences.

2. Select the measurement failure action:

= Select On Test Failure, pause the test and let me investigate to pause
the test when a failure occurs. Click the Status and Results buttons to
explore the failure condition. To resume the test, click Continue.

= Select On Test Failure, stop and notify me of the failure to stop the
test and send an email when a test fails. Click Email Settings to verify
that Email Test Results when complete or on error is selected, and to
verify the address to which the email is sent.
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Preferences tab parameters. Use the Preferences tab to set the application action
when a test measurement fails, and how the application handles opo-up error,
warning, and information messages during test sequences.

—V{*r/ TekExpress PCl Express - i 2] @ o°

Actions on Test Measurement Failure

[ On Test Failure, pause the test and let me investigate

[ On Test Failure, stop and notify me of the failure @

Popup Settings

[ Auto close Warnings and Informations during Sequencing

Auto close after |10

I_ Auto close Error Messages
Auto close after |10

Seconds

during Sequencing. Show in Reports
Seconds

Table 9: Preferences tab parameters

Parameter

Description

Actions on Test Measurement Failure

On Test Failure, stop and notify me of the failure

Stops the test sequence and sends an email
when a test falils.

On Test Failure, pause the test and let me
investigate

Pauses the test when a failure occurs. Click the
Status and Results buttons to explore the
failure condition.

To resume the test, click Continue.

Email Settings button

Click Email Settings to open the Email Settings
dialog box and verify that Email Test Results
when complete or on error is selected, and
verify the address to which the email is sent.

Popup Settings

Auto close Warnings and Informations during
Sequencing

Sets the time for how long the application
displays Warning and Information pop-up
messages before automatically closing the
messages and continues testing by taking the
default action.
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Parameter

Description

Show in Reports

Auto close Error Messages during Sequencing.

Sets the time for how long the application
displays Error pop-up messages before
automatically closing the messages and
continuing with testing. Message content is
added to the test report.

See also.
About setting up tests

Select report options

Status panel overview  The Status panel provides status on test acquisition and analysis (Test Status tab)

and a listing of test tasks performed (Log View tab). The application opens the
Test Status tab when you start a test run. You can select the Test Status or the

Log View tab to view these items while tests are running.

Test status view

TestMName

Acquire Status  Analysis Status

& Laned
i) 2.5Gbps Acquisition Tests 256

To be started To be started

(+] 5Gbps 3.5dB Acquisition Tests 5Gbps 3.5dB Acguisition To be started To be started
[+ 5Gbps 6dB Acquisition Tests SGbps 6dB Acguisition To be started To be started
(] Gbps PO Acquisition Tests 8Gbps PO Acqguisition To be started To be started
[+ 8Gbps P01 Acqguisition Tests BGbps P01 Acguisition To be started To be started
(] 2Gbps P02 Acquisition Tests BGbps P02 Acguisition To be started To be started
(+] 8Gbps P03 Acquisition Tests BGbps P03 Acguisition To be started To be started

[+ 8Gbps P04 Acqguisition Tests 8Gbps P04 Acquisition To be started To be started
() 8Gbps P05 Acquisition Tests BGbps P05 Acguisition To be started To be started

(+] 8Gbps P0§ Acqguisition Tests 8Gbps P06 Acquisition To be started To be started
(] &Gbps POT Acquisition Tests 8Gbps PO7 Acguisition To be started To be started
(+) 8Gbps P08 Acquisition Tests 8Gbps P08 Acquisition To be started To be started
(] 2Gbps P09 Acquisition Tests 8Gbps P0S Acguisition To be started To be started
[+ 8Gbps P10 Acquisition Tests BGbps P10 Acguisition To be started To be started
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Log view

:32:17 - Margin of result is : L:118.446mV
09/05/14 16:. : Compare limit -120.737 <=0 . Result:Pass
09/05/14 16:32:17 : Margin of result is : H:120.737m
09/05/14 16:32:17 : Compare limit 0.000 == EQ {=) : Result:Pass
09/05/14 16:32:17 : Margin of result is : H:Dhits
05/05/14 16:32:17 : Populating results for Non Transition Eye Diagram
8 : Compare limit -358.000 >=-600 : Result:Pass
: Margin of resutt is : L:242.000mV
Compare limit 358.000 <= 600 : Result:Pass
Margin of result is : H:242.000m\
Compare limit 2.07! : Result:Pass
Margin of result is : B’
: Compare limit 75270 <=0 : Result:Pass
8 : Margin of result is : H:79.270mV
09/05/14 16:32:18 : Compare limit 0.000 == EQ (=) : Result-Pass
05/05/14 16:32:18 : Margin of result is : H:Ohits
05/05/14 16:32:19 : Populating results for Min Eye Width
: Populating results for Min Time Between Crossovers
Populating results for T) & E-12
Compare limit 47.522 <= 77.0 : Resul Pass
Margin of result is : H:29.478ps
Populating results for Dj_dd
: : Compare limit 8266 <= 570 Result:Pass
:32:20 : Margin of result is : H:48.734ps
05/05/14 16:32-20 : Populating results for RJ[RMS)
05/05/14 16:32:20 : Populating results for Peak to Peal Jitter

05/05/14 16:32:20 : Analysis completed for 5Gbps 3.5dB for lane Lanel
09/05/14 16:32:21 : Test execution completed

The Log View display has several viewing options:
= Message History: This window timestamps and displays all run messages.

= Auto Scroll button : Select this check box to have the program automatically
scroll down as information is added to the log during the test.

m  Clear Log button : Click this button to clear all messages from the display.

= Save button : Click this button to save the log file as a text file. A standard
Save File window is displayed to name and save the file.

See also.

Application panel overview
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Results panel  Results panel overview. When a test finishes, the application switches to the
Results panel to display a summary of signal and preset test results. The Overall
Test Result is displayed at the top left of the Results table. If all of the tests for
the session pass, the overall test result is Pass. If one or more tests fail, the
overall test result is Fail.

Set viewing preferences for this panel from the Preferences menu in the upper
right corner. Viewing preferences include showing whether a test passed or
failed, summary results or detailed results, and enabling wordwrap.

Results panel

_VgTekExpressP(:l o @90
7 n

CTE I R N

Unit Interval Mean Unit 25Gbps 400.025 ps L:0.145ps
Interval & Pass H:0.095ps

Unit Interval Min Unit 2.5Gbps W Pass 400.025 ps L:0.145ps

Unit Interval m?::ar:it 25Gbps & Pass 400.025 ps H:0.095ps

Mask Hits(All Bits) Mask Hits 25Gbps & Pass 0 hits H:0hits

Composit Eye CompositEve 2.5Gbps 590.653mv NA

Height Height
MNumber Passing  Number 2.5Gbps
Eyes Passing Eyes
Number Failing Number 2.5Gbps
Eyes Failing Eyes
Transition Eye Min Transition 2.5Gbps
Diagram Eye Height
Transition Eye Min Transition 2.5Gbps
Diagram Voltage
Transition Eye Max Transition 2.5Gbps
Diagram Voltage
Transition Eye Min Transition 2.5Gbps
Diagram Top Margin
Transition Eye Min Transition 2.5Gbps
Diagram Bottom Margin

-, Transition Eye Transition Eye  2.5Gbps
Diagram Mask Hits

Mion Transition

Infarmative

@ Pass 2405 L-2495

# Pass 0 H0

Infarmative 651.349mV  |NA

-441.600my  L:158.400
my

434400 mYy  H:165.600
my

64.959 mV L:64.959m
v

&) Pass
& Pass

& Pass

-f2391mv H72.391m
v

0 hits H:Ohits

&) Pass

&) Pass

When a test finishes, the application switches to the Results panel, which displays
a summary of test results.

NOTE. NAN (Not A Number) is displayed in the test results if an invalid waveform
was supplied for the test.

Each test result occupies a row in the Results table. By default, results are
displayed in summary format with the measurement details collapsed and with
the Pass/Fail column visible. Change the view in the following ways:

= To expand all tests listed, select View Results Details from the Preferences
menu in the upper right corner.

= To expand and collapse tests, click the plus and minus buttons.

= To collapse all expanded tests, select Preferences > View Results
Summary.

®  To remove or restore the Pass/Fail column, select Preferences > Show Pass/
Fail.
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To enable or disable the wordwrap feature, select Preferences > Enable
Wordwrap.

To expand the width of a column, place the cursor over the vertical line that
separates the column from the column to the right. When the cursor changes
to a double-ended arrow, hold down the mouse button and drag the column to
the desired width.

To group and view the tests by Lane, Test, Equalization, Pass/Fail, use the
Preferences option in Results Panel.

To clear all test results displayed, click Clear.

See also.

View a report

About panels
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View test-related files. Files related to tests are stored in the My TekExpress\PCI
Express folder. Each test setup in this folder has a test setup file and a test setup
folder, both with the test setup name.

The test setup file is preceded by the TekExpress icon and usually has no visible
file name extension.

Inside the test setup folder is another folder named for the DUT ID used in the
test sessions. The default is DUTO001.

Inside the DUTO0O01 folder are the session folders and files. Each session also has
a folder and file pair, both named for the test session using the naming
convention (date) (time). Each session file is stored outside its matching session
folder:

[C)20110520_154553
[C)20110520_154713
[C)20110520_155111
[C)20110520_155920
[C)20110520_160103
v 20110520_154553
Vi 20110520 154713
v 20110520 155111
Vi 20110520_155920
vl 20110520_160103

Each session folder contains image files of any plots generated from running the
test session. If you selected to save all waveforms or ran tests using prerecorded
waveform files, these are included here.

The first time you run a new, unsaved session, the session files are stored in the
Untitled Session folder located at ..\My TekExpress\PCI Express. When you
name and save the session, the files are placed in a folder with the name that you
specify. A copy of the test files stay in the Untitled Session folder until you run a
new test or until you close the PCle application.

See also.
File name extensions

Before you click start
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Reports panel  Reports panel overview. Use the Reports panel to browse for reports, name and
save reports, select test content to include in reports, and select report viewing
options.

ID_(t\F'C\ Express\Reports\DUT001 pdf
PDF {* pdf;) v

For information on setting up reports, see Select report options. For information
on viewing reports, see View a Report.

See also.

About panels
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Select report options. Click the Reports button and use the Reports panel controls
to select which test result information to include in the report, and the naming
conventions to use for the report. For example, always give the report a unique
name or select to have the same name increment each time you run a particular

test.

Select report options before running a test or when creating and saving test
setups. Report settings are included in saved test setups.

In the Reports panel, select from the following report options:

Table 10: Report options

Setting

Description

Report Update Mode

Generate new report

Creates a new report.

Append with previous run session

Appends the latest test results to the end of the
current test results report.

Replace current test | In previous run, current | Select to replace current test results in the report
results session with the test result(s) of previous run in current
session.
In previous run, current| Select to replace current test results in the report
session with the test result(s) in selected run session’s
report. Click Q and select test result of any
other run session from another setup.
Report Creation Settings
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Setting

Description

Report name

Displays the name and location from which to
open a report. The default location is at \My
TekExpress\PCI Express\Reports\. The report
file in this folder gets overwritten each time you
run a test unless you specify a unique name or
select to auto increment the report name, this
option is selected by default.

Change the report name or location.

Do one of the following:

m  Inthe Report Path field, type over the
current folder path and name.

m  Double-click in the Report Path field and
then make selections from the popup
keyboard and click the Enter button.

Be sure to include the entire folder path, the file
name, and the file extension. For example: C:
Documents and Settings\your user name\My
Documents\My TekExpress\PCI Express
DUTO001_Test_72.7.1.3.mht.

Open an existing report.

Click Browse button to locate and select the
report file and then click View button at the
bottom of the panel.

Save as type

Saves a report in the specified file type. Lists
supported file types to choose from.

NOTE. If you select a file type different from the
default, be sure to change the report file name
extension in the Report Name field to match. By
default, report is generated in PDF format but
you can also generate the report in MHT format.

Auto increment report name if duplicate

Sets the application to automatically increment
the name of the report file if the application finds
a file with the same name as the one being
generated. For example: DUT001, DUT002,
DUTO03. This option is enabled by default.

NOTE.

If you choose, say ‘TID_345’, for DUT ID’, the
next report for a new run in the same session
will be named ‘TID_346’ which may contradict or
cause confusion. In this case, it is suggested
that you choose ‘TID_345_001’ for DUT ID,
since the next runs in the same session will
have report names generated with the last suffix
auto-incremented as follows — ‘TID_345_002’
and so on.
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Setting

‘ Description

Contents To Save

Include pass/fail info in details table

Select to include the column labeled Test Result
(indicating whether the test passed or failed) in
the report. For details, see Report Contents in
View a report.

Include detailed results

Sets the application to include parameter limits,
execution time, and test-specific comments
generated during the test.

Include plot images

Sets the application to include plotted diagrams
such as Eye diagrams.

Include setup configuration

Sets the application to include hardware and
software information in the summary box at the
top of the report. Information includes: the
oscilloscope model and serial number, probe
model and serial number, the oscilloscope
firmware version, SPC and factory calibration
status, and software versions for applications
used in the measurements.

Include user comments

Select to include any comments about the test
that you or another user added in the DUT tab of
the Setup panel. Comments appear in the
Comments section, under the summary box at
the beginning of each report.

Include switch matrix configuration

Select to include switch matrix configuration.

Group Test Results by

Test Name Select to display the test results by test name.
Lane Select to display the test results by lane.
Equalization Select to display the test results by equalization.

Pass or Fail Results

Select to display the test results by pass or fail
results.

Other

View Report After Generating

Automatically opens the report in a Web browser,
when the test completes. This option is selected
by default.

View button

Click to view the most current report.

Generate Report button

Generates a new report based on the current
analysis results.

See also.
View a report

About setting up tests
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View a report. The application automatically generates a report when test analysis
is completed and displays the report in your default Web browser (unless the
View Report After Generating check box is not selected). If this check box is
not cleared, or to view a different test report, do the following:

1. Click the Browse button and locate and select the report file to view.
2. In the Reports panel, click View.

For information on changing the file type, file name, and other report options, see
Select report options.
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Report contents. A report shows specified test details, as defined in the Reports

panel.

NOTE. NAN (Not A Number) is displayed in the report contents if an invalid
waveform was supplied for the test. In PDF generated report, hyperlinks do not
work and result table for some measurements maybe spread across a page.

Setup configuration information

Setup configuration information is listed in the summary box at the beginning of
the report. This information includes the oscilloscope model and serial number,
and software versions. To exclude this information from a report, clear the
Include Setup Configuration check box in the Reports panel before running the

test.

TekExpress PCl Express

Tektronix
Module Test Report
Setup
DuT ID DUTOO1 DPOJET Version 10.0.5.1
Date /Time 2017-09-12 11:15:49 Scope Model MS073304DX
Device Type U.2(SFF-8639) Scope Serial Number PQ00006
Tekexpress version PCI Express10.3.1.43 SPC, FactoryCalibration PASS,UNCAL
Framework:4.2.9.5 Scope F/W Version 10.7.1 Build 16
Test Mode SigTest User Defined Probel Model TCA-SMA
S vasEn KGN Probe2 Model TCA292D
SigTest Version SigTest 2.2.0(Gen1,2,3) Fielra? S N/A
Slot Number 0 Probe3 Model TCA-SMA
Overall Execution Time 00655 Probe4 Model TCA-SMA

Overall Test Result

Pass

DUT COMMENT: DUT001

Test Name Summary Table

Unit Interval Gen3

Composit Eve Height Gen3

Transition Eye Diagram Gen3

Non Transition Eve Diagram Gen3

Min Eye Width Gen3

Min Time Between Cre

rs Gen3

T1@E-12Gen3

Dj_dd Gen3

RIRMS) Gen3

Peak to Peak |itter Gen3

Test result summary

The Test Result column indicates whether a test passed or failed. If the test
passed, the column cell is green. If the test failed, it is red. To exclude this
information from a report, clear the Include pass/fail info in details table check
box in the Reports panel before running the test.

Unit Interval Gen1

Table 4-1

8: Transmitter Specifications

Measurement .
s Lane Name Data Rate Equalization | Measured Value| Test Result Margin Low Limit High Limit
Mean Unit 1:0.120ps

Laneo3 2.5Gbps 400.000 ps Pass 299.88 402.12
Interval H:2.120ps
Min Unit

Lane03 2.5Ghps 399.999 ps Pass L:0.110ps 300.88 N.A
Interval
Max Unit

Laneo3 2.5Gbps 400.000 ps Pass H:2.120ps N.A 402.12
Interval
T — Found Amplitude = 889,Found Data Rate = 2.5,Pattern Check = Pass PCl Express Base Specification Revision 4.0 v0.5

Back to Summary Table

Transition Eye Diagram Gen1

Measurement

i Lane Name Data Rate Equalization | Measured Value| Test Result Margin Low Limit High Limit
Min Transition

Lane03 2.5Gbps 750436 mV | Informative NA N.A NA
Eye Height
Min Transition

Lane03 2.5Gbps -497.075 mV | Pass 1:102.925mV | -600 N.A
Voltage
Max Transition

Lane03 2.5Gbps 488.102mV | Pass HI111.808mV | N.A 600
Voltage
Min Transition
TR | Laneos 2.5Gbps 239.710mv | Pass L230.710mv |0 NA
Top Margin
Min Transition

Lane03 2.5Gbps -245.726 mV | Pass H:245.726mV | N.A 0
Eottom Margin
Transition Eye Result

Lane03 2.5Gbps ; NA NA N.A NA
Mask Hits Unavailable

Found Amplitude = 889,Found Data Rate = 2.5.Pattern Check = Pass PCI Express Card Electromechanical Specification Revision 4.0
COMMENTS vo.5
Table 4-16

See also.
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Results panel overview

View test-related files
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Setting up and configuring tests

About setting up tests

Set up tests using the tabs in the Setup panel. Settings in the DUT tab use a top-
down, left-to-right logic flow, so that any parameter that affects or acts as a filter
for other parameters appears either to the top of or to the left of the affected
parameters.

Tests are saved when you save a test setup. To avoid overwriting test results,
remember to assign a unique name to the test either before running it or
immediately after.

I .
See also Test setup overview

Before you click start
About test setups

About running tests

Equipment connection setup

Click the Setup > Test Selection > Schematic button to open a PDF file that
shows the compliance test setup diagrams (instrument, DUT, and cabling) for
supported testing configurations.

See also . .
Minimum system requirements

View connected instruments

About setting up tests
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Equipment connection

setup through switch I
system GPIB aGor [I2|S S
y (| Oscilloscope AWG
2000 GRS
= DL LA Bl BNCoSMA 71 U
) ‘ dplayp) ayfdy Adapters
— CH1/ CHz| CH3\| cHa\ ™
GPIB
SMA-to-SMP —»
7 & - - 1 Meter
y'do ¢ |ede obe ¢ o o CBB3 (Riser) —» RX LANE O

DUT ADD-IN Card—~

iy | ‘ 1

Supply - 1
2 LAN~ S
5 7 po = ™ cag3 (Main)
5 O A TXLANE O
T B Power b4, & @\
] o o 0 connector / @, ; :\ Power Reset
=t g i
Power switch s

BRD REFCLK or External

CMTS Pulse button et CLK Swilch

Figure 3: Add-In card connection setup through switch system
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Gigatronics Switch: DUT Lane to Signal connection mapping

TX LANE O P S1 (relay) > Signal 1 | TXLANEON $3> Signal 1
TX LANE 1P S1> Signal 2 TX LANE 1N S3 > Signal 2
TX LANE 2 P S1> Signal 3 TX LANE 2N S3 > Signal 3
TX LANE 3P S1> Signal 4 TX LANE 3N S3 > Signal 4
TXLANE 4 P S1> Signal 5 TXLANE 4 N $3> Signal 5
TX LANE 5 P S1> Signal 6 TXLANE 5N S3 > Signal 6
TX LANE 6 P S1> Signal 7 TX LANE 6 N S3> Signal 7
TXLANE 7P S1> Signal 8 TXLANE 7N S3> Signal 8
TX LANE 8 P S4 > Signal 1 TX LANE 8 N S6 > Signal 1
TX LANE 9 P S4 > Signal 2 TX LANE 9N S6 > Signal 2
TX LANE 10 P S4 > Signal 3 TX LANE 10N S6 > Signal 3
TX LANE 11 P S4 > Signal 4 TX LANE 11N S6 > Signal 4
TX LANE 12 P S4 > Signal 5 TX LANE 12N S6 > Signal 5
TX LANE 13 P S4 > Signal 6 TX LANE 13N S6 > Signal 6
TX LANE 14 P S4 > Signal 7 TX LANE 14 N S6 > Signal 7
TX LANE 15 P S4 > Signal 8 TX LANE 15N S6 > Signal 8
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GPIB

o Oscilloscope

el L)
BNCAo-SMA 51 1

=T ¥ — = Adapters |
I, &
) Ap) 4y 4y B With Automated DUT control (AFG/AWG) ﬁ

= CH1/cH2 [ CH3|cH4| (7
GPIB t
SMA-to-SMP
1 Meter
) w 5
? [ »

. 16 REF CLK
,/ @xIREFCLK x16 COMP Presence
%16 COMP Detect Jurper
Bl e ooog
CLKMEAS @@@@@@@@@@
O000po ocoo©
g Qg Kogodgog

Back — xteCadbdge—p—[L] L | L[ 1J]—— xt6CardEdge —[  Front

Figure 4: System board (normal) connection setup through switch system

Gigatronics Switch: DUT Lane to Signal connection mapping

TXLANEOP S1 (relay) > Signal 1 | TXLANEON S3 > Signal 1
TXLANE 1P S1 > Signal 2 TXLANE 1N $3 > Signal 2
TXLANE 2P S1> Signal 3 TXLANE 2N S3 > Signal 3
TXLANE 3P S1> Signal 4 TXLANE 3N S3 > Signal 4
TXLANE 4 P S1> Signal 5 TXLANE 4N 83 > Signal 5
TXLANE 5P S1 > Signal 6 TXLANES5N S3 > Signal 6
TXLANE 6 P S1> Signal 7 TXLANE6N S3 > Signal 7
TXLANE 7 P S1> Signal 8 TXLANE 7N S3 > Signal 8
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Gigatronics switch

AFGor [5|S 55 5%
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Figure 5: System board (cascade) connection setup through switch system
Gigatronics Switch: DUT Lane to Signal connection mapping
TXLANEOP S1 (relay) > Signal 1 | TXLANEON S3 > Signal 1
TXLANE 1P S1 > Signal 2 TXLANE 1N S3 > Signal 2
TXLANE 2P S1> Signal 3 TXLANE 2N S3 > Signal 3
TXLANE 3P S1> Signal 4 TXLANE 3N S3 > Signal 4
TXLANE 4 P S1> Signal 5 TXLANE4N S3 > Signal 5
TXLANE 5P S1> Signal 6 TXLANES5N S3 > Signal 6
TXLANE 6 P S1> Signal 7 TXLANE 6N S3 > Signal 7
TXLANE 7P S1> Signal 8 TXLANE7N S3 > Signal 8
TXLANE 8 P S4 > Signal 1 TXLANE 8N S6 > Signal 1
TXLANE 9P S4 > Signal 2 TXLANE 9N S6 > Signal 2
TXLANE 10 P S4 > Signal 3 TXLANE 10N S6 > Signal 3
TXLANE 11 P S4 > Signal 4 TXLANE 11N S6 > Signal 4
TXLANE 12P S4 > Signal 5 TXLANE 12N S6 > Signal 5
TXLANE 13 P S4 > Signal 6 TXLANE 13N S6 > Signal 6
TXLANE 14 P S4 > Signal 7 TXLANE 14 N S6 > Signal 7
TXLANE 15 P S4 > Signal 8 TXLANE 15N S6 > Signal 8
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Setting up and configuring tests

NOTE. GPIB is the recommended interface to execute the switch matrix
commands.
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Running tests

Test setup overview

Test setup includes acquisition and configuration parameters. You can also select
report options when setting up tests. Use the options in the Setup panel and
Reports panel to select and configure tests.

Set up equipment.

Do the prerun checklist.

Set DUT parameters.

Select one or more tests.
Select acquisitions.
Configuration test parameters.

Set test measurement notification options.

Sl AU o e

Select report options.

See also About test setups

Before you click star

About running tests
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Prerequisite

62

Compensate the signal
path

Deskew

Use the following procedure to compensate the internal signal acquisition path.
Perform this procedure if the ambient temperature has changed more than 5 °C
(9 °F) since you performed the last signal path compensation. Perform the signal
path compensation once a week. Failure to do so may result in the instrument not
meeting warranted performance levels.

1. Power on and wait for the instrument to complete its warm up period before
continuing with this procedure.

Disconnect any probes you have connected to the input channels.
Set the instrument to Menu mode.
Select Instrument Calibration from the Utilities menu.

Note any instructions that appear in the resulting control window.

AR

Click Run SPC to begin the procedure. The procedure may take several
minutes to complete.

7. Verify that the Status changes to Compensated after the procedure is
complete. If the Calibration Status field indicates anything other than
Compensated, see Signal Path Compensation Status for information on the
readout and recommended action.

NOTE. When making measurements at vertical scale settings less than or equal to
5 mV, you should perform the signal path compensation at least once a week.
Failure to do so may result in the instrument not meeting warranted performance
levels at those volts/div settings.

If skew is present between positive and negative channels, then the channels need
to be deskewed before being used for waveform measurements. TekExpress PCle
provides support for channel deskew and attenuation using the following method:

1. Determine what the skew is for each channel.
2. From the TekScope menu, select Vertical > Deskew.

3. In the Deskew/Attenuation window, click the channel (1 — 4) button for the
first channel to be deskewed.

4. Click in the Ch(x) Deskew Time entry field and enter the skew. The skew
can be +ve or —ve.

5. Click the channel button for the next channel and repeat step 4.

6. After entering the skew for all the channels that require it, from the Options
menu in TekExpress PCle, select Deskew.
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7. In the Deskew dialog box, select the desired level:

= Less than 100 mV signal amplitude: Select this if the signal amplitude is
such that the oscilloscope’s vertical setting is less than 100 mV/division.

= 100 mV or greater signal amplitude: Select this if the signal amplitude is
such that the oscilloscope’s vertical setting is greater than 100 mV/
division.

Figure 6: Deskew
8. Click Read Deskew/Attn.

9. When the status in the dialog box indicates the deskew is finished, click
Close.

Each input channel has its own deskew settings. Deskew compensates individual
channels for probes or cables of different lengths. The instrument applies the
delay values after each completed acquisition. The deskew values are saved as
part of the instrument setup. The deskew values for the selected channel are
retained until you change the probe, you restore a saved setup, or you recall the
factory setup.
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Running tests

After selecting and configuring tests, review the Prerun checklist and then click
Start to run the tests. While tests are running, you cannot access the Setup or
Reports panels. To monitor the test progress, switch back and forth between the
Status panel and the Results panel.

The application displays a report when the tests are complete. While the tests are
running, other applications may display windows in the background. The
TekScope application takes precedence over other applications, but you can
switch to other applications by using the Alt + Tab key combination. To keep the
TekExpress PCle application on top, select Keep On Top from the TekExpress
Options menu.

I .
See also Before you click start

About configuring tests

About setting up tests

Prerun checklist Do the following before you click Start to run a test. If this is the first time you
are running a test on a setup, refer to the information in Before you click start.

1. Make sure that all the required instruments are properly warmed up
(approximately 20 minutes).

2. Perform Signal Path Compensation (SPC):
a. On the oscilloscope main menu, select the Utilities menu.
b. Select Instrument Calibration.

3. Verify that the application is able to find the DUT. If it cannot, perform a
search for connected instruments:

In PCle, select the Setup panel and then click the Test Selection tab.
b. Select any test and then click Configure.
c. n the Configuration section, click Global Settings.

d. In the Instruments Detected section, click the drop-down arrow to the
right of Real Time Scope and make sure that the oscilloscope with the
(GPIB8::1::INSTR) designation is in the list.

See also.

Equipment connection setup
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Saving and recalling test setups

About test setups

TekExpress PCle opens with the default setup selected. Run a test before or after
saving a setup. When you save a setup, the test information, such as the selected
oscilloscope, general parameters, acquisition parameters, measurement limits,
waveforms (if applicable), and other configuration settings are all saved under the
setup name at X:\PCI Express.

Use test setups to:
= Run a saved test in prerecorded mode.

= View all the information associated with a saved test, including the log file,
the history of the test status as it executed, and the results summary.

= Create a new test setup based on an existing one.

= Run a new session, acquiring live waveforms, using a saved test
configuration.

See also About setting up tests

Save a test setup

Recall a saved test setup
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Saving and recalling test setups

Save a test setup

66

See also

Save a test setup before or after running a test to save the test configuration.
Create a new test setup from any open setup or from the default setup. When you
select the default test setup, all parameters are returned to the application’s
default values.

To save the current setup session to the same setup name, select Options > Save
Test Setup.

To save the current setup session to a new setup name, select Options > Save
Test Setup As.

To create and save a new setup from the default test setup:

1.
2.

Select Options > Default Test Setup.

Select Setup and set required options and parameters in the tabs (DUT, Test
Selection, and so on).

Select Reports and set your report options.

Optional: Click Start to run the test and verify that it runs correctly and
captures the information you want. If it does not, edit the parameters and
repeat this step until the test runs to your satisfaction.

Running the test helps verify that all parameters are set correctly, but it is not
a necessary step.

Select Options > Save Test Setup. Enter the file name for the setup file. The
application saves the file to X:\PCI Express\<session_name.

About setting up tests

Test setup overview

View test-related files

About configuring tests
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Open (load) a saved test setup

See also

These instructions are for recalling saved test setups.

1. Select Options > Open Test Setup.

2. Select the setup from the list and click Open. Setup files must be located at
X:\PCI Express.

About test setups
Create a new test setup based on an existing one

Test setups overview

Create a new test setup based on an existing one

Use this method to create a variation on a test setup without having to create the
setup from the beginning.

1. Select Options > Open Test Setup.
2. Select a setup from the list and then click Open.

3. Use the Setup and Reports panels to modify the parameters to meet your
testing requirements.

4. Select Options > Save Test Setup As.

5. Enter a test setup name and click Save.

NOTE.

m  Select Default Test Setup before execution of every test and save the session
with a valid name; this will prevent overwriting/losing data.

®m  When you save session using the option Save Test Setup, the "Untitled
Session" folder and the "Untitled Session.Tekx" file will get renamed with the
session name provided by you. It takes few seconds to store the data in the

folder.

®  When you save session using the option Save Test Setup As, the " Untitled
Session" folder and the " Untitled Session.Tekx" fie will get named with
session name provided by you. It takes few seconds to store the data in the
folder. The same is applicable when you use the Save as option to save the
already saved session files.
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Saving and recalling test setups

See also

About test setups
Set DUT parameters

Configuration parameters

Select acquisitions
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Switch Matrix application

Product description

Switch Matrix application allows to configure and setup automated multi-lane
testing using RF switch. The solution allows you to map each of the several
transmitter signals and forward the selected input either to another relay or to the
oscilloscope channel.

Application overview

This section describes the Switch Matrix application settings.

GPIBO:4:INSTR @
Suitch Sell Test

3 I ©

elting:

e © ®

Rely C RelzyD

[ © [ © O @
) | [l © () |
) | ) | () |
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) | =) | () |
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Switch Matrix application

Table 11: Switch Matrix configuration settings

Item Description

Click to expand/collapse the switch matrix configuration.

Y
Options Click Help to view the software help document and About Switch
Matrix for software version.
Ontinns ¥

Help

About Switch Matrix
Switch Matrix configuration
Configuration Select the configuration option:

= Keithley S46T: 6-input-to-1-output switch configuration

= Gigatronics ASCOR 8000: 8-input-to-1-output switch
Configuration configuration

= Auto Detect: Select to autodetect the switch.

= New Configuration: Select to manually configure the switch.

Gigatronics ASCOR 8000 =  Saved file names: Saved configuration file name(s) are

Buto Detect displayed in the drop-down list. Select to recall the
Mew Corfiguration configuration.
Savel = Show All Files: Select to view the list of all saved files.

Show All Files

Select the vendor from the drop-down list. This field is displayed:

Vendor

= When you select Configuration > New Configuration to
create afresh configuration.

= When you open a saved configuration. The displayed vendor
name is not editable.

i—- _ = When Auto Detect is selected. The displayed vendor name is
Gigatronics not editable.
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Link Width

Item Description
Select the Link Width from the drop-down list. This determines the
Link Width maximum number of lanes supported by the DUT.

Add <X> more lane(s)

Add more lane(s)

Select to add extra lanes (Additional1, Additional2,....) to the lanes
list. The extra lanes added are displayed in the relay signals.
You can add a maximum of 10 lanes.

Rename Lanes

Click to rename the lanes. Enter the LanePrefix and select the
increment label type to suffix by either number or alphabet. The
number of lanes depends on the Link Width selected. Clear the Auto
rename lane check box to set unique names for the lanes.

Rename Lanes
—Renane Lanes o
Senai0
Sonai2
Signall4 Signalls
De-embed
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Item

Description

De-embed

embed

Mone
All relays (Recommended)

Each relay type separately (SPAT, SPET atc)

Each relay separately

Each connection

Select Fitter File

Select the De-embed option:

= None

= All relays (Recommended)

= Each relay type separately (SP4T, SP6T, efc.)
= Each relay separately

= Each connection

Select the de-embed option and click Select Filter File to browse
and select the filter file(s).

Debug Mode

1 Configure at least one relay before configuring the de-embed settings.

72
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Debug Mode

Switch Address

GPIED: 4 INSTR @
Switch Self-Test

E; |::|:||:|Ee .I'-I'I.Ijljr 4

GPIBE:1:INSTR @

Apply de-embed zettingz

Item Description
Select Debug Mode to manually configure the switch.
Debug Mode Switch Address

Enter the Switch Address in the GPIB or TCPIP format.

GPIB format: GPIBO:X:INSTR

TCPIP format: TCPIP::IPADDR:INSTR

Init Switch

This will synchronize the configuration of relay(s) in the application
with the relay(s) in the switch. Synchronization will be successful
only for the relays whose configuration matches with the physical
switch. Pass/Fail status is displayed next to the button.

NOTE. Relay configurations (number of relays, number of relay
inputs, and name of relays) in the application should match the
physical switch, for successful synchronization.

Switch Self-Test

This will close and open all switch channels one-by-one and
displays the pass/fail status of the channel next to the ID. A self-test
report (CSV) is generated at the end of the process. You cannot
abort this process.

NOTE. Initialize the switch before performing the self-test.

Reset Switch

Click Reset Switch to reset the switch. This will open all channels.
Scope Address

Enter the oscilloscope address in the GPIB or TCPIP format.
GPIB format: GPIBO:X:INSTR

TCPIP format: TCPIP::IPADDR::INSTR

Init Scope

Enter the oscilloscope address in the Scope Address field and click
Init Scope to initialize the oscilloscope. This will establish the
connection with the oscilloscope. The pass/fail status is displayed
next to the button.

Apply De-embed settings

Select to apply de-embed settings to the channels.

When the oscilloscope is initialized and de-embed settings are
configured, closing a connection will apply the de-embed settings
and then close the connection.

Relays
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Item Description
Select the relay(s). In SPnT, n represents the number of connection
Relays signals for the relay. For example, SP4T is a four signal connection

Relays
spzT (B sP37 E
seaT [E sPsT EE

speT I srev OIS

Load

relay.

This field displays only for a new configuration. By default, zero
relays are selected.

Enter the total number of relays to be loaded in their respective input
box and click Load.

You can also click L*_I or L™_| to increase or decrease the number.

Save

Save

Click to save the configuration at C:\ProgramData\Tektronix\Switch
Matrix Configurations\* xml.

This operation checks whether all the required configurations are
done. If any of the required configurations are not selected, then
error popup is displayed, which prompts you to complete the
configuration(s).

Clear All

Clear All

Click to clear all configurations. The application will be loaded with
Configuration drop-down (default).

Channel Status

Channel Status

Click to view the relays and status of channels of Keithley or
Gigatronics switch. This updates the channel status dynamically.

In Switch Channel Status Viewer, select the Vendor type, enter the
Switch Address and click Init to initialize the switch. This will
establish the connection with the switch.

Click Query Status to get the details of the relays of the switch and
the status of the channels.

Click Reset to reset the status viewer.

Switch Channel Status Viewer e

Felay 4 Felay B

[T 2 (R 4 G5 WS [ 7 B3 Y (S5 e
ClelEcEle  EeELt

CiclEiclEe  EeeLkt
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Item

Description

Graphical View

Graphical View

Click to view the graphical representation of the configured relays. If
the relays are cascaded, then they are also displayed in the
graphical representation.

Relay configuration

Signal Polarity

|59nal Polarity ‘-@- Positive | | Megative | | Differential

Select the signal polarity of DUT;
= Positive: populates Lane0+, Lane1+, .... connection signals.
= Negative: populates Lane0-, Lane1-, .... connection signals.

= Differential: populates Lane0, Lane1, .... connection signals.

Enter the relay name. This name should match the relay name of

Relay Name the connected switch.
Relay Name | Relay A
Delete Click to delete the relay. This configuration is only available for the
configured (loaded) relays, when Configuration > New Configuration
is selected.
Delete
Select to cascade the relay by connecting the common channel as
Cascade the input signal for another relay.
Select the Relay and the Input of the relay. Check that the selected
relay signal displays the appropriate relay name.
Relay Input The cascade settings is also displayed in the graphical view.
Cascade ] [ Click here to get details about Cascade.
Select - =

NOTE. Select the cascade settings before you save the
configuration.
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Item Description
Select the oscilloscope channel for Common. If cascaded, it displays|
Common the name of the relay.
Click Reset Inputs to clear all connection signal settings.
. [Cm .] [ Reset inputs NOTE. Select' the common settings for all the relays, before you
save the configuration.
Signal
Select the DUT connection signal. This drop-down list shows the
lanes based on Link Width and Signal Polarity settings.
Siel Input 1D EileiEle Clabe If the link width is x8 and signal polarity is Positive, then the Signal
drop-down list will have Lane0+ to Lane7+ options.
> . Input
This button is enabled only in debug mode and if a valid signal is
] ":o" configured for the channel. Click to close or open the channel.

ID

Enter the three character alias name for the channel. This is shown
in the graphical view of switch matrix configuration.

Filter File

This column shows & or 'ﬂ indicating the status of the filter file
configuration for the channel. If no de-embed option is selected,
then this column remains blank.

Status

This column displays the status of the channel.

B
Channel closed (normally closed) : M=

< o

Channel opened (normally opened) : M

76
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File name extensions

This application uses the following file name extensions:

File name extension

Description

.html

Saved configuration and Graphical view file formats

xml

Switch Matrix configuration files

Status indicators

Status indicators

Description

v

Success indicator

X

Failure indicator

Closed channel indicator (NC = Normally
Closed)

B
NC
- o
MO

Opened channel indicator (NO = Normally
Opened)

Saved configurations

Click Configuration > Show All Files to view the list of all saved files.

Saved Configurations
SelectF
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Table 12: Saved configurations

Item Description

Open Opens the selected file.

Delete Deletes the selected file.

Cancel Closes the Saved Configurations window.

De-embed settings

De-embed allows you to apply filter file(s) for relay(s). Select the De-embed
option and click Select Filter File to browse and select the filter file(s).

De-embed

Mone

All relays (Recommended)

Each relay type separately (SP4T, SPET etc)
Each relay separately

Each connection

Select Filter File

Figure 7: De-embed options

Apply afilter file for all  Select to apply a single filter file for all relays.
relays

Click =~ to browse and select the filter file for the switch. To apply the filter
file for the fixture, select Choose filter file for fixture and browse the filter file.
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Apply afilter file for each  Select to separately apply a single filter file for each relay type.
relay type separately

Select the Relay type from the drop-down list; click =~ to browse and select the
filter file for the switch. To apply the filter file for the fixture, select Choose
filter file for fixture and browse the filter file.

o TIP. Click = or #  toselect the previous or next relay type.

- TIP. The selected relay types are highlighted in dark blue in the application.

Apply afilter file for each  Select to separately apply a filter file for each relay.
relay separately
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o

Apply a filter file for each
connection separately

80

Select the Relay from the drop-down list; click =~ to browse and select the filter
file for the switch. To apply the filter file for the fixture, select Choose filter file
for fixture and browse the filter file.

TIP. Click =< or *  toselect the previous or next relay.

TIP. The selected relay is highlighted in dark blue in the application.

Select to apply a filter file for each connection.

Select the Relay and the Input from the drop-down list; click =~ to browse and
select the filter file for the switch. To apply the filter file for the fixture, select
Choose filter file for fixture and browse the filter file. Select Choose different
filter file for cable to browse and select the filter file for cable.

TIP. Click = < or > to select the previous or next channel.

TIP. The selected relay signal is highlighted in dark blue in the application.

NOTE. Clicking > on the last input of a relay selects the first input of the

next relay, clicking < on the first input of a relay selects the last input of
the previous relay.

TekExpress PCI Express Tx Compliance and Testing Solution Help



Switch Matrix application

Graphical view of switch matrix configuration

The Graphical view displays the pictorial representation of the switch
configuration.

The following figure displays the graphical view of a Keithley switch
configuration.

Switch Matrix

8’0 ©°6 6760 670 g.¢

Roley 8 ]

) ) )
e® ©g® ©g® ©g0

Saving the configuration

Click Save in the configuration panel; in the Configuration Save dialog box,
enter the file name and click Save. The default save path is C:\ProgramData
\Tektronix\Switch Matrix Configurations)\.

Configuration Save

NOTE. Save configuration checks whether all the required configurations are
done. If any of the required configurations are not selected, then error message is
displayed, which prompts you to complete the configuration(s).
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Feature description

Link width

Debug mode

82

Link width determines the number of DUT signals. For example, x8 represents an
eight lane DUT.

This works in conjunction with the signal polarity selected for each relay. For
example, if the link width is x8, and:

m  [f the signal polarity is Positive, then the signal drop-down list will have
selections from LaneO+ to Lane7+.

m  [f the signal polarity is Negative, then the signal drop-down list will have
selections from Lane0- to Lane7-.

m  [f the signal polarity is Differential, then the signal drop-down list will have
selections from Lane0 to Lane7.

Init Switch. Enter the Switch Address and click Init Switch to initialize the
switch. This will synchronize the configuration of relay(s) in the application with
the relay(s) in the switch. Synchronization will only be successful for those relays
that match the physical switch. Pass/Fail status is displayed next to the button.

The factory default GPIB address for Keithley (GPIBO::7::INSTR) and
Gigatronics (GPIBO::4::INSTR) is populated in the switch address based on the
configured vendor. You can enter the address in GPIB (GPIBO:X:INSTR) or
TCPIP (TCPIP::IPADDR::INSTR) format.

NOTE. Relay configurations (number of relays, number of relay inputs, and name
of relays) in the application should match the physical switch, for successful
synchronization.

Switch Self-Test. This will close and open all switch channels one-by-one. A
selftest report (CSV) is generated at the end of the process. You cannot abort this
process.

NOTE. Initialize the switch before performing the Switch Self-Test.

Reset Switch. Click Reset Switch to reset the switch. This will open all channels.
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Init Scope. Enter the oscilloscope address in the Scope Address field and click
Init Scope to initialize the oscilloscope. This will establish the connection with
the oscilloscope. The pass/fail status is displayed next to the button.

You can enter the address in GPIB (GPIB0O:X:INSTR) or TCPIP
(TCPIP::IPADDR::INSTR) format.

When the oscilloscope is initialized and de-embed settings are configured,
closing a connection will apply the de-embed settings and then close the
connection.

NOTE. The virtual GPIB address of the oscilloscope is GPIBS:.1.::INSTR.

NOTE. If oscilloscope fails to respond to the *IDN? query during initialization,
then the connection attempt is considered a failure.

Cascade (Relay cascade)  This feature allows you to cascade the relay by connecting the common channel
as an input signal for another relay.

To cascade, select Cascade in the relay and select the Relay and Input of the
relay. Check that the selected relay signal displays the relay name, specifying that
the lane input signal is the output from that relay.
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Figure 8: Graphical view of relay cascade configuration
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TIP. Switch Matrix application supports only single-level cascading of the relays.
For example, if the Relay A output is cascaded to Relay B, then the Relay B
output cannot be cascaded.

|

Error messages

Error message Possible solution

"A filename cannot be empty and it cannot
contain any of the following characters:\nt. ..\
V<> | *T@#S% A& () -+, /W <>
Also, the file name cannot be \"Keithley S46T\",
\"Gigatronics ASCOR 8000\",\"Select\", \"'New
Configuration\", \"Custom\" , \"Auto Detect\" or
\"Show All Files\"

Configure appropriate signals before the de- Select at least one signal for a relay before
embed settings. configuring the de-embed settings.

Either the instrument address is invalid or Check the GPIB connection from oscilloscope to
instrument is not connected. switch and verify the instrument address.

Error occurred while trying to recall the Re-create the configuration file or recall a
configuration settings. different configuration file.

Try re-creating configuration or recalling a
different configuration file.

Error occurred while trying to access the
connection for open/close operation.

Filter file <FilterFileName> not found. Reselect the de-embed filter file and try again.

Graphical view is not generated or does not

exist.

Initialize the switch Initialize the switch and then perform the switch
operations.

Instrument address doesn't belong to any Verify the switch address.

supported switch.

Instrument address is empty. Instrument address cannot be empty. Enter a
valid instrument address in the GPIB
(GPIBO:X:INSTR) or TCPIP
(TCPIP::IPADDR::INSTR) format.

No switch detected. Connect a Keithley or Check the GPIB connection from the

Gigatronics switch and try auto detection by oscilloscope to switch and whether the

selecting Configuration > Auto Detect. instrument is detected in TekVisa.

Number of relays cannot be more than 26

Please ensure that the name(s) of the
configured relay(s) match the ones present on
the physical switch.
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Error message

Possible solution

Relay name cannot be empty

Scope initialization failed. Check if the address
is valid and ensure that the instrument is
switched on and try again.

Validate the oscilloscope address try again.

Switch communication failed...

Ensure that the switch is on. Reset the switch
and try again.

Switch initialization failed. Check if the address
is valid and ensure that the instrument is
switched on and try again.

Validate the switch address and ensure that the
instrument is switched on. Try again.

The start count cannot be more than 74

Timeout Error. Either the command is invalid or
instrument is not active.

Check the command syntax and the connection
of the instrument by SWITCH:*IDN command.

Two or more lanes have same name. The lane
names should be unique.

Two or more relays have same name.
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About SCPl command

You can use Standard Commands for Programmable Instruments (SCPI) to

communicate with the TekExpress application.

Socket configuration for SCPI commands

This section describes the steps for TCPIP socket configuration and TekVISA

configuration to execute the SCPI commands.

TCPIP socket 1.
configuration

Click Start > Control Panel > System and Security > Windows Firewall >
Advanced settings

e

:Eg

—
@uvlﬂ » Control Panel » System and Security » Windows Firewall - | &,l

Search Con... O |

Control Panel Home

Allow a program or feature
through Windows Firewall

) Change notification settings

%) Turn Windows Firewall on or
off

| Restore defaults
[ ) Advanced settings

Troubleshoot my network

See also
MAction Center

Network and Sharing Center

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.,

How does a firewall help protect my computer?

What are network locations?

@ For your security, some settings are managed by your system administrator.

. [@ Domain networks

Metworks at a workplace that are attached to a domain

Connected (4)

Windows Firewall state: On

Incoming connections: Block all connections to programs that are not on the

list of allowed programs

Active domain networks: ij tektroniz.net

Metification state: Do net notify me when Windows Firewall blocks a

new program

. '@ Home or work (private) networks Not Connected V

. '@) Public networks

Not Connected (¥

@
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2. In Windows Firewall with Advanced Security menu, select Windows
Firewall with Advanced Security on Local Computer > Inbound Rules
and click New Rule...

r 3
@ Windows Firewall with Advanced Security =S

File Action View Help

EY

P Windows Firewall with Advancd [l Actions

Inbound Rul B
DDOUNG LU e Mame Group Profile  Ensbled  Action Inbaund Rules -
Outbound Rules :
B Connection Security Rules B3 NewRuie...
» % Monitoring T Filter by Profile

W Fiter by State
Y Fiter by Group

v v ¥l

View
[ Refresh
|5 Exportlist...
Help
Tektronix VISA Call Monitor &
# Disable Rule

& cut

52 Copy

K Delete

[E] Properties

Help

< m v ||l m

3. In New Inbound Rule Wizard menu
a. Select Port and click Next

-
ﬂ New Inbound Rule Wizard ﬂ

Rule Type
Select the type of firewall nule to create.

Steps:

@ Rule Type What type of nule would you like to create?

@ Protocol and Ports

@ Action ) Program

@ Prefile Rule that controls connections for a program.
@ MName @ Port

Rule that controls connections for a TCP or UDP port.
) Predefined:

BranchCache - Content Retrieval {Uses HTTF)
Fule that controls connections for 8 Windows experience.

Custom rule.

Leam more about nile types

< Back Neat > Cancsl
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b. Select TCP as rule apply and enter 5000 for Specific local ports and
click Next

-
0 New Inbound Rule Wizard ﬂ

Protocol and Ports
Specify the protocols and ports to which this rule applies.

Steps:

@ Rule Type Does this rule apply to TCP or UDP?
@ Protocol and Ports @ TCP

@ Action ) UDP

@ Profile

@ Name

Does this rule apply to all local ports or specific local ports?

1 All local ports

@ Specific local ports: 5000
Example: 80, 443, 5000-5010

Leam more about protocol and ports

<Back [ Net> | [ Cancel

c. Select Allow the connection and click Next

-
0 MNew Inbound Rule Wizard ﬁ

Action

Specify the action to be taken when a connection matches the conditions specfied in the rule.

Steps:
@ Rue Type What action should be taken when a connection matches the specified conditions?
@ Protocol and Ports .

: @ Allow the connection
L) BRI This includes connections that are protected with IPsec as well as those are not.
@ Profile .

) Allow the connection if it is secure

@ Name

This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in |Psec properties and nules in the Connection Security
Rule node

") Block the connection

Leam more about actions

<Back [ Net> ][ Cancel
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d. Select Domain, Private, Public and click Next

-
ﬂ New Inbound Rule Wizard ﬂ

Profile

Specify the profiles for which this rule applies.

Steps:

@ Fuls Type When does this rule apply?

@ Protocol and Ports

@ Action Domain

@ Profile Applies when a computer is connected to its corporate domain.
@ MName Private

Applies when a computer is connected to a private network location.

Public
Applies when a computer is connected to a public network location

Leam more about profiles

<Back [ Net> | [ Cancel

e. Enter Name, Description (optional), and click Finish

-
ﬂ MNew Inbound Rule Wizard ﬁ

Name

Specify the name and description of this rule

Steps:

Rule Type
Protocol and Ports
Action

Profiie Name:

TekExpresyd

& & & & &

Name

Description {optional):

<Back |[ Fmsh ][ Cancel
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4. Check whether the Rule name is displayed in Windows Firewall with
Advanced Security menu > Inbound Rules

r
@ Windows Firewall with Advanced Security =S

File Acton View Help
| HE =

Inbound Rul
Mlobound Rules Name Group Profile  Enabled  Action “ || Inbound Rules -
Outbound Rules

Y. Connection Security Rules || SHUEEEIES All Ves Allow &3 NewRue...
& %L Monitoring T Filter by Profile

N Filter by state
Y Fiter by Group

v v v v

View
[ Refresh
|5 Exportlist...
H reb
TekExpress -
# Disable Rule

& cut

g Copy

K Delete

[E] Properties

H Hep
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92

TekVISA configuration

1.

Click Start > All Programs > TekVISA > OpenChoice Instrument

Manager

CpenChoice Instrument Manager

Fle Edit Help

Instruments

GPIB8::1::INSTR

< | m

Last Updated: 12/17/2015 10:34 PM

Instrument List Instrument
Update Identify...

w | O

Search Criteria.. Properties.

Applications and Utilities

OpenChoice Call Monitor
OpenChoice Talker Liste. ..

Start Application or Utility

Tekironix
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2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on.
Select Socket from the drop-down list, enter the IP address of the

TekExpress device in Hostname and type Port as 5000. Click to
configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application
are in the same system, else enter the IP address of the TekExpress
application system.

-
Search Criteria | =

v Search LAM

[~ Auto Discovery

Hostname Port
|Socket ~| | |[s000 |

[Socket| 127.0.0.1 5000
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3. Click Search to setup the TCPIP connection with the host. Check whether
the TCPIP host name is displayed in OpenChoice Instrument Manager >
Instruments

OpenChoice Instrument Manager [=[E[T=n]

Fle Edit Help

Instruments Applications and Utilities

OpenChoice Call Monitor
OpenChoice Talker Liste

¥ Search LAN

I~ Auto Discovery

Hostname Port

(s I—

[Eackef] 127.0.0.1 5000

<[ i
Last Updated: 12/17/2015 10:35 PM
Instrument List
Update
“ Start Application or Utility
-~

Search Criteria.-

Tekironix

4. Double-click OpenChoice Takler Listener and enter the Command *IDN?
in command entry field and click Query. Check that the Operation is
successful and Talker Listener Readout displays the Command / Data.

-
3 OpenChoice Talker Listener = ne

fle Edit Toos Help

Enter Command or Script
"IDN?

Wite  Read  Query  Hex Eniry Enabled
( . . |

Command / Seript History

Last Updated 12/17/2015 10:36 PM JAutoQuery - False ; Term Char - LF

Update Reset Communications Run Single Step Loop
S A 4

Talker Listener Readout: Display As: @ ASCIOnly @ Hex and ASCI

Command / Data
12/17/2015 10:... 0.0170s VISA TCPIP::127.0.0.1::5000::50CKET Qpen Session
1217/2015 1 0.0008s MS054 . *IDN? Write

121772015 1 0.0775s TCPIP:... TekExpress Read

@ Operation Successful
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TEKEXP:*IDN?

Syntax

Inputs

Outputs

[::;ﬂ

TEKEXP:*OPC?

Syntax

Inputs

Outputs

This command queries the active TekExpress application name running on the
oscilloscope.

TEKEXP:*IDN?\n

NA

Returns active TekExpress application name running on the oscilloscope.

TIP. Click here for examples.

This command queries the execution status of the last executed command.

TEKEXP:*OPC?\n

NA

0 - last command execution is not complete

1 - last command execution is complete

TIP. Click here for examples.
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TEKEXP:ACQUIRE_MODE

Syntax

Inputs

Outputs

I:’:;:—r

This command sets the acquire mode as live or pre-recorded.

TEKEXP:ACQUIRE _MODE {LIVE | PRE-RECORDED}\n

{LIVE | PRE-RECORDED}

NA

TIP. Click here for examples.

TEKEXP:ACQUIRE_MODE?

Syntax

Inputs

Outputs

o

96

This command queries the acquire mode type.

TEKEXP:ACQUIRE MODE?\n

NA

{LIVE | PRE-RECORDED}

TIP. Click here for examples.
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TEKEXP:EXPORT

Inputs

Ty

TEKEXP:INFO?

This command returns all the bytes of data to the specified file.

Syntax

Outputs

TEKEXP:EXPORT REPORT\n

Returns the report file in bytes

TEKEXP:EXPORT WFM,"<FileName>"\n

Returns the specified waveform file in bytes

TEKEXP:EXPORT IMAGE,"<FileName>"\n

Returns the specified image file in bytes

FileName - Specifies the file name

TIP. Click here for examples.

This command queries the information about the file(s).

Syntax

Outputs

TEKEXP:INFO? REPORT\n

<ReportFileSize>,"<ReportFileName.mht>"

TEKEXP:INFO? WFMi\n

<WfmFile1Size>,"<WfmFileName1.wfm>";<Wfm
File2Size>,"<WfmFileName2.wfm>";...

TEKEXP:INFO? IMAGE\n

<Image1FileSize>,"<Image1FileName>";<Image
2FileSize>,"<Image2FileName>" ;...

TIP. Click here for examples.
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TEKEXP:INSTRUMENT

This command sets the value for the selected instrument type.

Syntax ~ TEKEXP:INSTRUMENT "<InstrumentType>",<Value>"\n

Inputs  InstrumentType

Value
o TIP. Check Command parameters list for InstrumentType and Value parameters.
Outputs NA
w TIP. Click here for examples.

TEKEXP:INSTRUMENT?

This command queries the instrument selected for the specified instrument type.

Syntax ~ TEKEXP:INSTRUMENT? "<InstrumentType>"\n

Inputs  InstrumentType

TIP. Check Command parameters list for InstrumentType parameters.

o
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Outputs  Returns the instrument selected for the specified instrument type

o TIP. Click here for examples.

TEKEXP:LASTERROR?

This command queries the last error string occurred for the current TCP session.
If there are no errors since startup, or since the last call to
TEKEXP:LASTERROR?\n, this command returns an empty string.

Syntax ~ TEKEXP:LASTERROR?\n

Inputs NA

Outputs  <string>

o TIP. Click here for examples.

TEKEXP:LIST?

This command queries the list of available device, suite, test, version or

instrument.

Syntax Outputs

TEKEXP:LIST? DEVICE\n Returns the list of available device(s) as comma
separated values.

TEKEXP:LIST? SUITE\n Returns the list of available suite(s) as comma
separated values.

TEKEXP:LIST? TEST\n Returns the list of available test(s) as comma
separated values.

TEKEXP:LIST? VERSION\n Returns the list of available version(s) as comma
separated values.

TEKEXP:LIST? Returns the list of available instruments' for the

INSTRUMENT,"<InstrumentType>"\n given Instrument type as comma separated
values.
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Inputs

TEKEXP:MODE

Syntax

Inputs

Outputs

.::jﬂ

100

NOTE. This command returns the list of items within double quotes ("'"). Iterate
the receive procedure until the list ends with double quotes otherwise the next
query commands won’t work as expected.

InstrumentType

TIP. Check Command parameters list for InstrumentType parameters.

TIP. Click here for examples.

This command sets the execution mode as compliance or user defined.

TEKEXP:MODE {COMPLIANCE | USER-DEFINED}\n

{COMPLIANCE | USER-DEFINED}

NA

TIP. Click here for examples.
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TEKEXP:MODE?

This command queries the execution mode type.

Syntax ~ TEKEXP:MODE?\n

Inputs NA

Outputs ~ {COMPLIANCE | USER-DEFINED}

" TIP. Click here for examples.

TEKEXP:POPUP

This command sets the response to the active popup shown in the application.

Syntax ~ TEKEXP:POPUP “<PopupResponse>"\n

Inputs  PopupResponse

Outputs NA

o TIP. Click here for examples.
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TEKEXP:POPUP?

Syntax

Inputs

Outputs

I::‘;:—r

TEKEXP:REPORT

Syntax

Inputs

Outputs

o

102

This command queries the active popup information shown in the application.

TEKEXP:POPUP?\n

NA

Returns the active popup information in the application.

TIP. Click here for examples.

This command generates the report for the current session.

TEKEXP:REPORT GENERATE\n

GENERATE

NA

TIP. Click here for examples.
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TEKEXP:REPORT?

This command queries the queried header field value in the report.

Syntax ~ TEKEXP:REPORT? “<HeaderField>"\n

Inputs  HeaderField - Specifies to return the measured value for the indicated test.

TIP. Check Report for HeaderField parameters.

Outputs  Returns the queried header field value in the report

o TIP. Click here for examples.

TEKEXP:RESULT?

This command queries the result available in report summary/details table.

Syntax Outputs

TEKEXP:RESULT? "<TestName>"\n Return Pass/Fail status of the test.
TEKEXP:RESULT? Returns all the row values of the specified
"<TestName>","<ColumnName>"\n column for the test.

TEKEXP:RESULT? Returns the column value for the specified row
"<TestName>","<ColumnName>",<RowNumber | number '

>\n

1" Row number starts from zero.
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Inputs

TEKEXP:SELECT

Syntax

Inputs

104

TestName - Specifies the name of the test for which to obtain the test result
value.

ColumnName - Specifies the column name for the measurement

RowNumber - Specifies the row number of the measurement

TIP. Check Results panel for TestName, ColumnName, and RowNumber
parameters.

TIP. Click here for examples.

This command selects the device, suite, version, or test.

TEKEXP:SELECT <string1>,<string2>,<string4>\n
TEKEXP:SELECT TEST,<string3>,<string4>\n

<string1>= {DEVICE | SUITE | VERSION}

<string2> = {DeviceName | SuiteName | VersionName}
<string3> = {“<TestName>"| ALL| REQUIRED }
<string4>= {TRUE | FALSE}

TIP. Check Command parameters list for DeviceName, SuiteName, VersionName,
and TestName parameters.

TIP. Click here for examples.
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Outputs

TEKEXP:SELECT?

Syntax

Inputs

Outputs

[

TEKEXP:SETUP

Inputs

[

NA

This command queries the name of the selected device, suite, version, or test.

TEKEXP:SELECT? {DEVICE | SUITE | TEST | VERSION}\n

{DEVICE | SUITE | TEST | VERSION}

Returns the name of the selected device, suite, version, or test.

TIP. Click here for examples.

This command sets the value of the current setup.

Syntax Outputs
TEKEXP:SETUP DEFAULT\n Restore to default Setup
TEKEXP:SETUP OPEN,"<SessionName>"\n | Open the session
TEKEXP:SETUP SAVE\n Save the session
TEKEXP:SETUP SAVE,"<SessionName>"\n Save the session

SessionName - The name of the session

TIP. Click here for examples.
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TEKEXP:STATE

Syntax

Inputs

Outputs

[:_::—

TEKEXP:STATE?

106

This command sets the execution state of the application.

TEKEXP:STATE {RUN | STOP | PAUSE | RESUME}\n

{RUN | STOP | PAUSE | RESUME}

NA

TIP. Click here for examples.

This command queries the current setup state.

Syntax Outputs

TEKEXP:STATE? RUNNING | PAUSED | WAIT | ERROR | READY
| STOPPED

TEKEXP:STATE? SETUP SAVED | NOT_SAVED

TIP. Click here for examples.
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TEKEXP:VALUE

This command sets the value of parameters of type General, Acquire, Analyze, or
DUTID.

Syntax =~ TEKEXP:VALUE GENERAL,"<ParameterName>",“<Value>"\n

TEKEXP:VALUE ACQUIRE,“<TestName>","<AcquireType>",
"<ParameterName>",“<Value>"\n

TEKEXP:VALUE ANALYZE,“<TestName>","<ParameterName>".“<Value>"
\n

TEKEXP:VALUE DUTID,“<Value>"\n

Inputs  ParameterName - Specifies the parameter name
TestName - Specifies the test name
AcquireType - Specifies the acquire type

Value - Specifes the value to set

TIP. Check Command parameters list for ParameterName, AcquireType, and

wwr Value parameters.
Outputs NA
v TIP. Click here for examples.
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TEKEXP:VALUE?

This command queries the value of the parameter for type General, Acquire,
Analyze, or DUTID.

Syntax Outputs

TEKEXP:VALUE? Returns the value of Parameter for type
GENERAL,"<ParameterName>"\n GENERAL

TEKEXP:VALUE? ACQUIRE,"<TestName>", | Returns the value of Parameter for type
"<AcquireType>","<ParameterName>"\n ACQUIRE

TEKEXP:VALUE? ANALYZE, Returns the value of Parameter for type
“<TestName>","<ParameterName>"\n ANALYZE

TEKEXP:VALUE? DUTID\n Returns the DUTID value

Inputs  ParameterName - Specifies the parameter name
TestName - Specifies the test name

AcquireType - Specifies the acquire type

o TIP. Check Command parameters list for ParameterName and AcquireType
! parameters.

Outputs  Returns the value of Parameter for type GENERAL | ACQUIRE | ANALYZE |
DUTID.

TIP. Click here for examples.
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Command parameters list

This section provides the parameters list for the SCPI commands.

Parameters

Description

InstrumentType

Specifies the instrument type.
Valid values are:

= Alternate Real Time Scope

= Real Time Scope

Value

Specifies the value parameters.

= For InstrumentType, valid values are:
= Comment

= For DUTID, valid values are:

= Comment

DeviceName

Specifies the device name. Valid values are CEM, U.2(SFF-8639), and BaseSpec

SuiteName

Specifies the suite name.

For CEM, valid values are System-Board, Add-In-Card
For U.2(SFF-8639), valid values are Host, Module

For BaseSpec, valid value is TX Test Board
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Parameters Description

VersionName Specifies the version name.
Valid values are:

= Gen1-1.0a (Applicable only for DeviceName = CEM)
= Gen1-1.1 (Applicable only for DeviceName = CEM)
= Gen2-2.0 (Applicable only for DeviceName = CEM)
= Gen3-3.0

= Gend-4.0
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Parameters

Description

TestName

Specifies the test measurement name.
Valid values for CEM and U.2(SFF-8639) are:

= Unit Interval

= Mask Hits(All Bits)

= Composit Eye Height

= Number Passing Eyes

= Number Failing Eyes

= Transition Eye Diagram

= Non Transition Eye Diagram
= Min Eye Width

= Min Time Between Crossovers
= RMS litter (Per Edge)

= Median Peak Jitter

s TJ@E-12
= Djdd
= RJRMS)

= Peak to Peak Jitter

NOTE. Add one space at the end of the test name to select the 5Gbps tests and two spaces to select

the 8Gbps tests.

Valid values for BaseSpec are:
s ACCM4GHz

= AC CM 30KHz-500MHz
= EIEOS Min Voltage

= VTx_no_eq

= DD
= F/2 Jitter
= PS21 Ratio

m  PWJRJ(RMS)

m  TIERJ(RMS)

= Uncorrelated PWJ DJ dd@E-12
= Uncorrelated PWJ TI@E-12

= Uncorrelated TIE DJ dd@E-12
= Uncorrelated TIE TJ @ E-12
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Table 13: ParameterName and Value for General

Specifies the ParameterName and Value for General. The configuration
parameters available are not same for measurements.

ParameterName Value
DataRate2Gb = Included
= Excluded
DataRate5Gb = Included
= Excluded
DataRate8Gb = Included
= Excluded
DataRate16Gb = Included
= Excluded
PreEmphasis3dB = Included
= Excluded
PreEmphasis6dB s Included
= Excluded
SSC ™ On
m Off
VoltageSwing = Full
= Reduced
Link Widths 1Lane
SignalPreset8Gb Signal quality preset selection values are PO, P1, P2, P3, P4, P5, P6, P7, P8, P9, P10.
SignalPreseti6Gb To select multiple signal quality preset, specify as PO_P1_P2
Preset8Gb Preset selection values are PO_, P1_, P2_, P3_, P4_, P5_, P6_, P7_, P8_, P9_, P10_.
Preset16Gb To select multiple signal quality preset, specify as P0_P1_P2
Acquisition BeforeAnalysis
SaveOptions Save All the Waveforms
DeEmbed2Gb = Included
= Excluded
DeEmbed5Gb = Included
= Excluded
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ParameterName Value
DeEmbed8Gb = Included
= Excluded
DeEmbed16Gb = Included
= Excluded
Embed8Gb = Included
= Excluded
Equalization8Gb = Included
= Excluded
Filterfile2Gb Filterfile2Gb.fit
Filterfile5Gb Filterfile5Gb.fit

FilterfileDeEmbed8Gb

FilterfileDeEmbed8Gb.flt

FilterfileEmbed8Gb

FilterfileEmbed8Gb.flt

EmbedDropdown

m  SigTest
= Scope
EqualizationDropdown = Optimize
= Fixed
CTLE Index 1:-12dB
DFE -30e-3
EnableDUTAutomation «  Included
= Excluded
Automation Settings Use Default Settings
Signal Type = Square
= Sine
RecordLength2Gb 2.5e6
RecordLength5Gh 10e6
RecordLength8Gb 10e6
RecordLength16Gb 20e6
SampleRate2Gb 50e9
SampleRate5Gb 50e9
SampleRate8Gb 50e9
SampleRate16Gb 100e9
Bandwidth2Gh 7e9
Bandwidth5Gb 12.5e9
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ParameterName Value
Bandwidth8Gb 12.5e9
Bandwidth16Gb 16€9
Signal Validation Turn Off Signal Check
SlotNumber 05
Toggle from Gen3P10 to Gen1 on

= Off
Signal Validation Threshold(mV) | 200
AnalysisMode CLI
Report Update Mode . New

= Append

= Replace
Auto increment report name if | TRUE or FALSE
duplicate
Include Pass/Fail Results TRUE or FALSE
Summary
Include Detailed Results TRUE or FALSE
Include Plot Images TRUE or FALSE
Include Setup Configuration TRUE or FALSE
Include Complete Application TRUE or FALSE
Configuration
Include User Comments TRUE or FALSE

Save As Type

= Web Archive (*.mht;*.mhtml)
= PDF (*.pdf)

View Report After Generating

TRUE or FALSE

Report Group Mode

= TestName
= Lane Name
= Test Result

= Equalization

Create report at the end

= Included
= Excluded
DUTID Comment User comment
Number of retries for instrument |0 to 5
10 errors
Run Test More than Once TRUE or FALSE
Number of Runs 1to 100
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ParameterName

Value

On Failure Rerun

TRUE or FALSE

Number of Reruns On Failure 1to 100

Time between retries (seconds) |5 to 60

Timer Warning Info Message
Popup

m "True"
= "FALSE"

Timer Warning Info Message 0to20
Popup Duration

Timer Error Message Popup

m "True"

= "False"

Timer Error Message Popup 0to20
Duration

On Failure Stop and Notify

TRUE or FALSE

Examples
This section provides the examples for the SCPI commands.
Example Description
TEKEXP:*IDN?\n It returns the active TekExpress application name running on the scope.
TEKEXP:*OPC?\n It returns the last command execution status.
TEKEXP:ACQUIRE_MODE PRE- It sets the acquire mode as pre-recorded.
RECORDED\n
TEKEXP:ACQUIRE_MODE?\n It returns LIVE when acquire mode is set to live.
TEKEXP:EXPORT REPORT\n It returns the report file in bytes. This can be written into another file for further analysis.

TEKEXP:INFO? REPORT\n

It returns “100,”ReportFileName.mht™, when 100 is the filesize in bytes for the filename
ReportFileName.

TEKEXP:INFO? WFMi\n

It returns “100,“WfmFileName1.wfm™;“200,“WfmFileName2.wfm™ when 100 is the filesize
in bytes for the filename WfmFileName1.wfm and 200 is the filesize in bytes for the
filename WfmFileName2.wfm.

TEKEXP:INSTRUMENT "Real Time
Scope",DPO72504D ( GPIB8::1::INSTR )\n

It sets the instrument value as DPO72504D ( GPIB8::1::INSTR ) for the selected instrument
type Real Time Scope.

TEKEXP:INSTRUMENT? “Real Time Scope”
\n

It returns "IDPO72504D ( GPIB8::1::INSTR ), when DPO72504D ( GPIB8::1::INSTR )" is
the selected instrument for the instrument type Real Time Scope.

TEKEXP:LASTERROR?\n

It returns ERROR: INSTRUMENT_NOT_FOUND, when no instrument is found.

TEKEXP:LIST? DEVICE\n

It returns "TX-Device,RX-Device" when TX-Device, RX-Device are the available device.

TEKEXP:LIST? INSTRUMENT,"Real Time
Scope"\n

It returns "DPO72504D ( GPIB8::1:INSTR ),MSO72504 ( TCPIP::134.64.248.91::INSTR )"
when DPO72504D ( GPIB8::1::INSTR ), MSO72504 ( TCPIP::134.64.248.91::INSTR ) are
the list of available instruments.

TEKEXP:MODE COMPLIANCE\n

It sets the execution mode as compliance.
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Example Description

TEKEXP:MODE?\n It returns COMPLIANCE when the execution mode is compliance.
TEKEXP:POPUP “OK"\n It sets OK as the response to active popup in the application.
TEKEXP:POPUP?\n It returns "OK", when OK is the active popup information shown in the application.

TEKEXP:REPORT GENERATE\n

It generates report for the current session.

TEKEXP:REPORT? “Scope Model"\n

It returns "DPO73304SX" when DPO73304SX is the scope model.

TEKEXP:REPORT? “DUT ID"\n

It returns "DUT001" when DNI_DUTO001 is the DUT ID.

TEKEXP:RESULT? "Period using SCOPE
(Acquire-Analyze Combined)"\n

It returns Pass when the test result is Pass.

TEKEXP:RESULT? "Period using SCOPE
(Acquire-Analyze Combined)","Margin",1\n

It returns "L:-50.000ps H:2000.000ps" when L:-50.000ps H:2000.000ps is the value.

TEKEXP:SELECT DEVICE, TX_Device,
TRUE\n

It selects TX_Device

TEKEXP:SELECT? DEVICE\n It returns "TX-Device" when TX-Device is the selected device type.
TEKEXP:SETUP DEFAULT\n It restores the application to default setup.

TEKEXP:STATE STOP\n It stops the test execution.

TEKEXP:STATE?\n It returns as READY when the application is ready to run next measurement.
TEKEXP:STATE? SETUP\n It returns as NOT_SAVED when the current setup is not saved.

TEKEXP:VALUE GENERAL,"Signal Type",
“N1NO"\n

It sets the signal type parameter value to N1NO.

TEKEXP:VALUE? GENERAL,"Signal
Type"\n

It returns "NTNO" when N1NQ is the Signal Type value.
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Switch Matrix commands

This section describes the switch matrix commands. It is recommended to
execute the switch matrix commands through GPIB interface.

SWITCH:*IDN  This command queries the switch matrix version information.
Syntax. SWITCH:*IDN?\n
Inputs. NA
Outputs. Returns the switch martrix version information.

Example. SWITCH:*IDN?\n returns "Tektronix,Switch Matrix,v1.0.0.0", where
v1.0.0.0 is the Switch Matrix version.

SWITCH:*OPC  This command queries the previously executed commands execution status.
Syntax. SWITCH:*OPC?\n
Inputs. NA

Outputs. Returns 0 if the previously executed command execution is in progress.

Returns 1 if the previously executed command execution is done.

Example. SWITCH:*OPC?\n returns 1, when the previously executed command
execution is done.

SWITCH:CONFIG  This command sets or queries the config file.
Syntax. SWITCH:CONFIG {"<ConfigName>" | "<UserConfigFilePath>"}\n
SWITCH:CONFIG?\n
Inputs. <ConfigName> specifies the config file.
<UserConfigFilePath> specifies the config file from the given path.
Outputs. Returns the loaded config file name with path.
Examples. SWITCH:CONFIG "Keithley S46T"\n sets the config file of Keithley.
SWITCH:CONFIG "E:\myconfig.xml"\n sets the config file from the given path.
SWITCH:CONFIG?\n returns "E:\myconfig.xml".
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SWITCH:DE-
EMBED:ALL:FILTER_FILE

SWITCH:DE-
EMBED:CONN:FILTER _FIL
E

SWITCH:DE-
EMBED:FILTER FILE

118

This command sets the filter file for all connections.

Syntax. SWITCH:DE-EMBED:ALL:FILTER _FILE
"<SwitchFilterFilePath>","<FixtureFilterFilePath>"\n

Inputs. <SwitchFilterFilePath> specifies the switch filter file path.
<FixtureFilterFilePath> specifies the fixture filter file path.
Outputs. NA

Example. SWITCH:DE-EMBED:ALL:FILTER_FILE "C:\FilterFiles
\SWTCHI.f1t","C:\FilterFiles\CABLE _1.fIt"\n sets the switch filter file for all
connections and the fixture filter file for all cables connected.

This command sets the filter file for the switch, fixture, and cable for the
specified connection.

Syntax. SWITCH:DE-EMBED:CONN:FILTER FILE
"<RelayName>","<InputName>","<SwitchFilterFilePath>","<FixtureFilterFilePa
th>""<CableFilterFilePath>"\n

Inputs. <RelayName> specifies the relay name.

<InputName> specifies the input name.

<SwitchFilterFilePath> specifies the switch filter file path.
<FixtureFilterFilePath> specifies the fixture filter file path.
<CableFilterFilePath> specifies the cable filter file path.

Example. SWITCH:DE-EMBED:CONN:FILTER FILE "Relay A","1","C:

\FilterFiles\RA 1.fIt","C:\FilterFiles\Fxtre 1.flt","C:\FilterFiles\cbl 1.flt"\n sets
filter files to Relay A's input 1 and to the connected cable.

This command queries the filter file based on the mode selected in the
application.

Syntax. SWITCH:DE-EMBED:FILTER _FILE?\n
Inputs. NA

Outputs. Returns the filter file in any of the the below specified format, based on
the mode selected.

None
ALL;"<SwitchFilterFilePath>","<FixtureFilterFilePath>";

RELAY_TYPE;"<RelayType1>","<SwitchFilterFilePath1>","<FixtureFilterFilePath1>";"<Relay Type
2>""<SwitchFilterFilePath2>","<FixtureFilterFilePath2>";

RELAY;"<RelayName1>" "<SwitchFilterFilePath1>","<FixtureFilterFilePath1>";"<RelayName2>","<
SwitchFilterFilePath2>" "<FixtureFilterFilePath2>";

CONN;"<RelayName1>","<InputName1>,"<SwitchFilterFilePath1>","<FixtureFilterFilePath1>","<C
ableFilterFllePath1>;"<RelayName1>","<InputName2>,"<SwitchFilterFilePath2>","<FixtureFilterFil
ePath2>""<CableFilterFllePath2>;
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Example. SWITCH:DE-EMBED:FILTER FILE?\n returns ALL;"C:\FilterFiles
\SWTCHIL.fIt" ,"C:\FilterFiles\Fxtre 1.flt".

SWITCH:DE-  This command sets or queries the De-Embed mode.
EMBED:MODE g\ tax. SWITCH:DE-EMBED:MODE {NONE | ALL | RELAY TYPE |
RELAY | CONN'\n
SWITCH:DE-EMBED:MODE?\n
Inputs. {NONE | ALL | RELAY TYPE | RELAY | CONN}

Outputs. Returns the De-Embed mode.

Examples. SWITCH:DE-EMBED:MODE ALL\n sets the De-Embed mode as
ALL.

SWITCH:DE-EMBED:MODE?\n returns ALL.

SWITCH:DE-  This command sets the filter file and fixture file for the specified relay.

EMBED:RELAY:FILTER_FI g\ ntay SWITCH:DE-EMBED:RELAY:FILTER FILE
LE "<RelaName>","<SwitchFilterFilePath>","<FixtureFilterFilePath>"\n

Inputs. <RelaName> specifies the relay name.
<SwitchFilterFilePath> specifies the switch filter file path.
<FixtureFilterFilePath> specifies the fixture filter file path.

Outputs. SWITCH:DE-EMBED:RELAY:FILTER FILE "Relay A","C:
\FilterFiles\RA.flt","C:\FilterFiles\Fxtre 1.flt"\n sets filter files for all
connections in Relay A.

SWITCH:DE-  This command sets the filter file for specified relay type.

EMBED:RELAY_TYPE:FIL Syntax. SWITCH:DE-EMBED:RELAY TYPE:FILTER FILE
TER_FILE "<RelayType>","<SwitchFilterFilePath>","<FixtureFilterFilePath>"\n

Inputs. <RelayType> specifies the relay type.
<SwitchFilterFilePath> specifies the switch filter file path.
<FixtureFilterFilePath> specifies the fixture filter file path.

Example. SWITCH:DE-EMBED:RELAY TYPE:FILTER FILE "SP2T","C:
\FilterFiles\SP2T.flt","C:\FilterFiles\Fxtre 1.flt"\n sets filter file for SP2T relay

type.
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SWITCH:LASTERROR  This command queries the error occurred while executing last command.
Syntax. SWITCH:LASTERROR?\n
Inputs. NA

Outputs. Returns the error occurred while executing last command.

Error message

Description

NO_ERROR

No error occurred executing last command.

INVALID_COMMAND

The last command sent is either invalid or
syntax is not correct.

"No config file loaded."

The last command to load the config file is
failed.

“Invalid configuration."

The last command has invalid configuration.

"Invalid linkwidth."

The last command has invalid linkwidth.

"Invalid de-embed mode.

The last command has invalid de-embed mode.

"Invalid signal polarity."

The last command has invalid signal polarity.

"Invalid relay name."

The last command has invalid relay name.

"Invalid relay type."

The last command has invalid relay type.

“Invalid signal name."

The last command has invalid signal name.

"Invalid common value."

The last command has invalid value for
common.

“Invalid input ID."

The last command has invalid input ID.

Example. SWITCH:LASTERROR?\n returns the last error occurred.

SWITCH:LINKWIDTH  This command sets or queries the link width.
Syntax. SWITCH:LINKWIDTH {X2 | X4 | X8 | X16}\n
SWITCH:LINKWIDTH?\n
Inputs. {X2 | X4 | X8 | X16}
Outputs. Returns the link width value.
Examples. SWITCH:LINKWIDTH X8\n sets the linkWidth to 8.
SWITCH:LINKWIDTH?\n returns 8.
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SWITCH:RELAY:CASCAD  This command sets or queries the cascade of the relay.

E Syntax. SWITCH:RELAY:CASCADE
"<FromRelayName>","<ToRelayName>","<InputName>"\n

SWITCH:RELAY:CASCADE? "<RelayName>"\n

Inputs. <FromRelayName> specifies the relay name from which to cascade.
<ToRelayName> specifies the relay name to cascade.

<InputName> specifies the input name of the relay to cascade.

<RelayName> specifies the relay name.

Outputs. Returns the cascading info of the relay if cascaded else returns
NOT_CASCADED.

Example. SWITCH:RELAY:CASCADE "Relay A","Relay B","2"\n sets Relay
A's output cascade to Relay B's input 2.

SWITCH:RELAY:CASCADE? "Relay A"\n returns "Relay B","2".
SWITCH:RELAY:CASCADE? "Relay B"\n returns NOT CASCADED.

SWITCH:RELAY:CASCAD  This command sets or queries cascaded state of the relay.
ED Syntax. SWITCH:RELAY:CASCADED "<RelayName>",{TRUE | FALSE}\n
SWITCH:RELAY:CASCADED? "<RelayName>"\n
Inputs. <RelayName> specifies the relay name.
TRUE or FALSE to cascade the relay or not.
Outputs. Returns whether the relay is cascaded or not.

Examples. SWITCH:RELAY:CASCADED "Relay A", TRUE\n sets the cascaded
state of Relay A to TRUE.

SWITCH:RELAY:CASCADED? "Relay A"\n returns TRUE.

SWITCH:RELAY:COMMON  This command sets or queries the relays common connection connected to scope
channels.

Syntax. SWITCH:RELAY:COMMON "<RelayName>",{CH1 | CH2 | CH3 |
CH4}\n

SWITCH:RELAY:COMMON? "<RelayName>"\n

Inputs. <RelayName> specifies the relay name.

{CHI | CH2 | CH3 | CH4} specifies the channel number.

Outputs. Returns the channel connected to the common connection of relay.

Example. SWITCH:RELAY:COMMON "Relay A",CH1\n sets the common
connection of Relay A to CHI.

SWITCH:RELAY:COMMON? "Relay A"\n returns CH1.
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SWITCH:RELAY:POLARIT  This command sets or queries the signal polarity of the specified relay.

Y Syntax. SWITCH:RELAY:POLARITY "<RelayName>",{POS | NEG | DIFF}\n

SWITCH:RELAY:POLARITY? "<RelayName>"\n
Inputs. <RelayName> specifies the relay name.

{POS | NEG | DIFF} specifies the signal polarity as Positive, Negative or
Differential respectively.

Outputs. Returns the signal polarity of the relay.

Examples. SWITCH:RELAY:POLARITY "Relay A",POS\n sets the Relay A's
signal polarity to POS.

SWITCH:RELAY:POLARITY? "Relay A"\n returns POS.

SWITCH:RELAY:SIGNAL  This command sets or queries the signal name connected to input port.

Syntax. SWITCH:RELAY:SIGNAL
"<RelayName>","<InputName>","<SignalName>"\n

SWITCH:RELAY:SIGNAL? "<RelayName>","<InputName>"\n
Inputs. <RelayName> specifies the relay name.

<InputName> specifies the input name of the relay.

<SignalName> specifies the signal name to connect to the relays input.
Outputs. Returns the signal name connected to the input port.

Example. SWITCH:RELAY:SIGNAL "Relay A","1","Lane0+"\n sets the signal
name Lane0+ to Relay A's input 1.

SWITCH:RELAY:SIGNAL? "Relay A","1"\n returns "Lane0+".
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De-embed using filter files

TekExpress PCle provides an option to de-embed the signal path using filter
files. You create the filter files. The filter files are .flt files composed of de-
embed filter coefficients for a particular sampling rate. A filter file created for
one sampling rate might not work for other sampling rates, so it is important to
understand at what sampling rate the measurements are being performed.

Also, the de-embedding filters might differ based on the type of input. For
example, if a single ended input is made using a matched SMA cable pair, a filter
file for de-embedding a single SMA cable must be provided, since matched SMA
cables mostly have similar s-parameters. So in this case, the same filter file is
used to de-embed the SMA cable pair.

The maximum sampling rate provided on any channel combination on MSO/
DPO/DSA70000/C/D/DX series oscilloscopes is 50 GS/s in realtime mode. The
maximum sampling rate provided on Ch1-Ch3 and Ch2-Ch4 channel
combinations on MSO/DPO/DSA70000C/D/DX series oscilloscopes is 100 GS/s,
provided only 2 channels are on at a given time.

See also
Common test parameters and values

Configuration test parameters
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Setup files

TekExpress PCI Express package contains setup files (*.TekX) which can be
used at PCIE Gen3 workshop for compliance tests.

Table 14: Setup files configuration details

Setup files (*.TekX)

Configuration details (exclusively used in Gen1/2/3 Gold Suite of PCI-SIG Work Shop (WS))

WorkShop_CEM_AIC _x1

Specification - CEM

Device Type - Add-In-Card

Version - Gen3 - 3.0

Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
Link Width - 1 Lane (Selected test lane; L0)

Automated DUT Control - unchecked

Signal Validation - Pattern Decoding

SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_CEM_AIC_x2

Specification - CEM

Device Type - Add-In-Card

Version - Gen3 - 3.0

Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

Signal Quality Preset Selection - P0, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
Link Width - 2 Lanes (Selected test lane: L0)

Automated DUT Control - unchecked

Signal Validation - Pattern Decoding

SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_CEM_AIC _x4

Specification - CEM

Device Type - Add-In-Card

Version - Gen3 - 3.0

Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
Link Width - 4 Lanes (Selected test lane: L0, L03)

Automated DUT Control - unchecked

Signal Validation - Pattern Decoding

SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report
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Setup files (*.TekX)

Configuration details (exclusively used in Gen1/2/3 Gold Suite of PCI-SIG Work Shop (WS))

WorkShop_CEM_AIC_x8

= Specification - CEM

= Device Type - Add-In-Card

= Version-Gen3-3.0

= Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 8 Lanes (Selected test lane: L0, L03, L07)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_CEM_AIC _x16

m  Specification - CEM

= Device Type - Add-In-Card

= Version - Gen3-3.0

= Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 16 Lanes (Selected test lane: L0, L07, L15)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_CEM_SYB_x1

= Specification - CEM

= Device Type - Add-In-Card

= Version-Gen3-3.0

= Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 1 Lane (Selected test lane: L0)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report
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Setup files (*.TekX)

Configuration details (exclusively used in Gen1/2/3 Gold Suite of PCI-SIG Work Shop (WS))

WorkShop_CEM_SYB_x2

= Specification - CEM

= Device Type - Add-In-Card

= Version-Gen3-3.0

= Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 2 Lanes (Selected test lane; L0)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_CEM_SYB_x4

m  Specification - CEM

= Device Type - Add-In-Card

= Version - Gen3-3.0

= Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 4 Lanes (Selected test lane: L0, L03)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_CEM_SYB_x8

= Specification - CEM

= Device Type - Add-In-Card

= Version-Gen3-3.0

= Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 8 Lanes (Selected test lane: L0,L03,L07)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report
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Setup files (*.TekX)

Configuration details (exclusively used in Gen1/2/3 Gold Suite of PCI-SIG Work Shop (WS))

WorkShop_CEM_SYB_x16

= Specification - CEM

= Device Type - Add-In-Card

= Version-Gen3-3.0

= Data Rates - 2.5 Gbps, 5 Gbps (Tx equalization 3.5dB, 6 dB) and 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 16 Lanes (Selected test lane: L0,L07,L15)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_U2_Module_x1

= Specification - U.2 (SFF8639)

= Device Type - Module

= Version - Gen3-3.0

= Data Rates - 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 1 Lane (Selected test lane: L0)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_U2_Module_x2

= Specification - U.2 (SFF8639)

= Device Type - Module

= Version - Gen3-3.0

= Data Rates - 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 2 Lanes (Selected test lane: L0)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report
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Setup files (*.TekX)

Configuration details (exclusively used in Gen1/2/3 Gold Suite of PCI-SIG Work Shop (WS))

WorkShop_U2_Module_x4

= Specification - U.2 (SFF8639)

= Device Type - Module

= Version-Gen3-3.0

= Data Rates - 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 4 Lanes (Selected test lane; L0,L03)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_U2_Host_x1

= Specification - U.2 (SFF8639)

= Device Type - Host

= Version - Gen3-3.0

= Data Rates - 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 1 Lane (Selected test lane: L0)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report
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Setup files (*.TekX) Configuration details (exclusively used in Gen1/2/3 Gold Suite of PCI-SIG Work Shop (WS))
WorkShop_U2_ Host _x2

= Specification - U.2 (SFF8639)

= Device Type - Host

= Version-Gen3-3.0

= Data Rates - 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 2 Lanes (Selected test lane; L0)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

WorkShop_U2_Host x4 = Specification - U.2 (SFF8639)

= Device Type - Host

= Version - Gen3-3.0

= Data Rates - 8 Gbps

= Signal Quality Preset Selection - PO, P7 and P8 for L0 and All Presets from PO to P10 for Lane0
= Link Width - 4 Lanes (Selected test lane: LO, L03)

= Automated DUT Control - unchecked

= Signal Validation - Pattern Decoding

= SigTest Interface Mode: CMD line - SigTest displayed and its HTML report saved with TE Report

How to open a setup file 1. Click Options > Open Test Setup

2. Select the TekExpress Setup File as per your required configuration. Check
Setup files configuration details table for configuration details.

Select File Name

WorkShop_CEM_AIC_x16
WorkShop_CEM_AIC_x2

WorkShop_CEM_AIC_x4
WorkShop_CEM_AIC_x8
WorkShoo CEM SYB x1

3. Make the configuration details and start the test execution.
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4. Click Save Test Setup As and save the setup.

NOTE. You cannot edit the TekExpress Test Setup files as they are in Read
Only mode.

NOTE. The setup files path is C:\Program Files\Tektronix\TekExpress\TekExpress
PCI Express\Setup Files

RF Switch configuration ~ TekExpress PCI Express package contains RF Switch configuration files.
files
File name Configuration details

PCE_Keithley_SYB_x6 Recall this file for Keithley S46T RF Switch and System-Board device type. The below are the
configuration details:

= Lane0 Positive to Lane05 Positive connected as Signal Inputs to Relay S1.
= Lane0 Negative to Lane05 Negative connected as Signal Inputs to Relay S3.

= Common output of relay A, B is connected to CH1, CH3 of the oscilloscope respectively. For 2-
Unit, SX box >= 59 GHz, set the common outputs to CH1, CH3 respectively.

= Connect the Ref Clock Positive and Negative from CLB to CH3, CH4 of oscilloscope. For 2-Unit,
SX box >=59GHz, set the Ref Clock Positive and Negative to CH2 and CH4 respectively.

PCE_KthCCD_SYB_x12 Recall this file for Keithley S46T RF Switch and System-Board device type. The below are the
configuration details;

= Lane0 Positive to Lane05 Positive connected as Signal Inputs to Relay A which is Cascade to
Relay 4 and Input to NO.

= Lane0 Negative to Lane05 Negative connected as Signal Inputs to Relay B which is Cascade to
Relay 5 and Input to NO.

= Lane06 Positive to Lane11 Positive connected as Signal Inputs to Relay C which is Cascade to
Relay 4and Input to NC.

= Lane06 Negative to Lane11 Negative connected as Signal Inputs to Relay D which is Cascade to
Relay 5 and Input to NC.

= Relay 4 is selected as Positive and Relay 5 as Negative; common output of 4 and 5 is connected
to CH1, CH2 of the oscilloscope respectively. For 2-Unit, SX box >= 59 GHz, set the common
outputs to CH1, CH3 respectively.

= Connect the Ref Clock Positive and Negative from CLB to CH3, CH4 of oscilloscope. For 2-Unit,
SX box >=59GHz, set the Ref Clock Positive and Negative to CH2 and CH4 respectively.
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File name

Configuration details

PCE_Giga_SYB_x8

Recall this file for Gigatronics ASCOR 8000 Series RF Switch and System-Board device type. The
below are the configuration details:

= Lane0 Positive to Lane07 Positive connected as Signal Inputs to Relay S1.
= Lane0 Negative to Lane07 Negative connected as Signal Inputs to Relay S3.

= Common output of relay S1, S3 is connected to CH1, CH3 of the oscilloscope respectively. For 2-
Unit, SX box >= 59 GHz, set the common outputs to CH1, CH3 respectively.

= Connect the Ref Clock Positive and Negative from CLB to CH3, CH4 of oscilloscope. For 2-Unit,
SX box >=59GHz, set the Ref Clock Positive and Negative to CH2 and CH4 respectively.

PCE_GigCCD_SYB_x16

Recall this file for Gigatronics ASCOR 8000 Series RF Switch and System-Board device type. The
below are the configuration details:

= Lane0 Positive to Lane07 Positive connected as Signal Inputs to Relay S1 which is Cascade to
Relay S2 and Input to NO.

= Lane0 Negative to Lane07 Negative connected as Signal Inputs to Relay S3 which is Cascade to
Relay S5 and Input to NO.

= Lane08 Positive to Lane15 Positive connected as Signal Inputs to Relay S4 which is Cascade to
Relay S2 and Input to NC.

= Lane08 Negative to Lane15 Negative connected as Signal Inputs to Relay S6 which is Cascade to
Relay s5 and Input to NC.

= Relay S2 is selected as Positive and Relay S5 as Negative; common output of S2 and S5 is
connected to CH1, CH2 of the oscilloscope respectively. For 2-Unit, SX box >= 59 GHz, set the
common outputs to CH1, CH3 respectively.

= Connect the Ref Clock Positive and Negative from CLB to CH3, CH4 of oscilloscope. For 2-Unit,
SX box >=59GHz, set the Ref Clock Positive and Negative to CH2 and CH4 respectively.
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File name

Configuration details

PCE_Keithley_AIC_x12

Recall this file for Keithley S46T RF Switch and Add-In-Card device type. The below are the
configuration details:

Lane0 Positive to Lane05 Positive connected as Signal Inputs to Relay A.
Lane0 Negative to Lane05 Negative connected as Signal Inputs to Relay B.
Lane08 Positive to Lane11 Positive connected as Signal Inputs to Relay C.
Lane08 Negative to Lane11 Negative connected as Signal Inputs to Relay D.

Common output of relay A, B, C ,D is connected to CH1, CH2, CH3, CH4 of the oscilloscope
respectively. For 2-Unit, SX box >= 59 GHz, set the common outputs to CH1, CH3, CH2 and CH4
respectively.

PCE_Giga_AIC_x16

Recall this file for Gigatronics ASCOR 8000 Series RF Switch and Add-In-Card device type. The below
are the configuration details:

Lane0 Positive to Lane07 Positive connected as Signal Inputs to Relay S1.
Lane0 Negative to Lane07 Negative connected as Signal Inputs to Relay S3.
Lane08 Positive to Lane15 Positive connected as Signal Inputs to Relay S4.
Lane08 Negative to Lane15 Negative connected as Signal Inputs to Relay S6.

Common output of relay S1, S2, S3, S4 is connected to CH1, CH2 , CH3, CH4 of the oscilloscope
respectively. For 2-Unit, SX box >= 59 GHz, set the common outputs to CH1, CH3, CH2 and CH4
respectively.
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A apply a filter file for all relays, 78
apply a filter file for each connection separately,
Acquire live waveforms, 26 80
Acquire parameters apply a filter file for each relay separately, 79
including in test reports, 49 apply a filter file for each relay type separately, 79
viewing in reports, 52 De-embedding, 123
Acquisition tab, 33 Detailed log view, 43
Acquisitions tab Device parameters, 26

refresh channel sources info, 38 Device profile connections, 55

set channel sources, 38 Device profiles, 26

set waveform save options, 36 DPOJET Plug-In, 6
set waveform source (prerecorded files), 37 DUT ID, 26
setAcquire options, 35 DUT parameters, 26
view detected probes, 38 DUT type
Activate the license, 9 10GBase-KR, 26
Advanced View, 55 40GBase-KR;1, 26

Application overview, 69
Application version, 9 E
Automate RF switch, 33
Email notifications, 22
B Email settings, 21
Equipment setup, 55
Bandwidth, 40 Error messages, 85
Evaluation mode, 13

C Exiting the application, 14

F

File name extensions, 11

Cascade, 83
Cascade (relay cascade), 83
Channel Status, 74

Command buttons, 15 Filter files, 123

Comments, 26 Free trials, 13, 55

Compensate the signal path, 62

Compliance Mode, 40, 55 G

Compliance View, 55

Configuration parameters, 40 Global settings, 40

Configuring email notifications, 22 Graphical view of switch matrix configuration, 81

Connected instruments
searching for, 20 H
Connection requirements, 55
Help conventions, 2

D Host tests, 55

De-embed settings
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Initialize the oscilloscope, 83

Installing the software
DPOIJET Plug-In, 6

TekExpress application for PCle, 6
Instruments
discovering connected, 19

viewing connected, 20
Instruments and accessories required, 4

Instruments detected, 40

K

Keep On Top, 13
Key, 13

L

lanes, 33

Lanes
number of, 26
License, 13

License activation, 9
License agreement, 9
Limits Editor, 40
Link width, 82
Loading a test setup, 67
Log view

save file, 43
Log view tab, 43

Measurement limits, 40
Menus, 17

Mode
Compliance, 40

User Defined, 40
Module tests, 55

My TekExpress folder
files stored in, 47

location of, 7

N

Notifications (test failure), 42
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Opening a saved test setup, 67
Options menu
Instrument control settings, 19
Keep On Top, 13
Oscilloscope compensation, 62
Overall test result, 45

P

Panels, 23
Pass/Fail summary
viewing, 52
Pass/Fail Summary
including in reports, 51
Plot images
including in reports, 51
viewing, 52
Preferences menu, 45
Preferences parameters, 42
Preferences tab, 25, 42

Prerecorded waveform files, 26, 33

prerecorded waveform files (acquisitions), 37

Prerun checklist, 64
Probes (acquisitions), 38

R

Reactivate the license, 9

Real time oscilloscope, 40
Recalling a test setup, 67

Record length, 40

Refresh sources (acquisitions), 38
Related documentation, 1

Relay cascade, 83

Relay configuration
cascade, 75

common, 76

relay name, 75

signal, 76

signal polarity, 75
Report name, 50
Report options, 49
Report sections, 52
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Reports
adding user comments to, 26

receiving in email notifications, 22
Reports panel, 23, 48

Resource file, 13

Results panel, 45

RF switch, 33

RF Switch configuration file details, 130

S

Sample Rate, 40

Sampling rate, 123

Saving test setups, 66

Saving tests, 47

Saving the switch matrix configuration, 81

SCPI commands
Command parameters list, 109

Examples, 115

SWITCH:*IDN, 117

SWITCH:*OPC, 117

SWITCH:CONFIG, 117
SWITCH:DE-EMBED:ALL:FILTER FILE, 118

SWITCH:DE-EMBED:CONN:FILTER FILE,
118

SWITCH:DE-EMBED:FILTER FILE, 118
SWITCH:DE-EMBED:MODE, 119

SWITCH:DE-EMBED:RELAY_ TYPE:
FILTER _FILE, 119

SWITCH:DE-EMBED:RELAY:FILTER FILE,
119

SWITCH:LASTERROR, 120
SWITCH:LINKWIDTH, 120
SWITCH:RELAY:CASCADE, 121
SWITCH:RELAY:CASCADED, 121
SWITCH:RELAY:COMMON, 121
SWITCH:RELAY :POLARITY, 122
SWITCH:RELAY:SIGNAL, 122
TEKEXP:*IDN?, 95
TEKEXP:*OPC?, 95
TEKEXP:ACQUIRE_MODE, 96
TEKEXP:ACQUIRE_MODE?, 96
TEKEXP:EXPORT, 97
TEKEXP:INFO?, 97

TEKEXP:INSTRUMENT, 98
TEKEXP:INSTRUMENT?, 98
TEKEXP:LASTERROR?, 99
TEKEXP:LIST?, 99
TEKEXP:MODE, 100
TEKEXP:MODE?, 101
TEKEXP:POPUP, 101
TEKEXP:POPUP?, 102
TEKEXP:REPORT, 102
TEKEXP:REPORT?, 103
TEKEXP:RESULT?, 103
TEKEXP:SELECT, 104
TEKEXP:SELECT?, 105
TEKEXP:SETUP, 105
TEKEXP:STATE, 106
TEKEXP:STATE?, 106
TEKEXP:VALUE, 107

TEKEXP:VALUE?, 108
Selecting test report contents, 49

Selecting tests, 32
Session files, 47
Session folders, 47
Set acquisition Acquire options, 35
Set waveform save options, 36
Setting up equipment, 55
Setting up tests, 55, 61
Setup files, 124
Setup panel, 23, 25
Setup panel views, 26
Software installation, 6
Software version, 9
Sources (acquisitions), 38
Status indicators, 77
Status panel, 43
Support, 2
Switch matrix configuration
additional lanes, 71
configuration, 70
de-embed, 72
debug mode, 73
graphical view, 75
link width, 71
relays, 74
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rename lanes, 71

vendor, 70
Switch self test, 82

System requirements, 3

T

Technical support, 2

TekExpress application for PCle, 6
Test failure action, 42

Test groups, 32

Test parameters (Configuration tab), 40
Test reports, 52

Test results
emailing, 22
Test selection controls, 32

Test setup files, 47
Test setup steps, 61

Test setups
creating, 67

load, 67
open, 67
recalling, 67
saving, 66
Test status tab, 43
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Test-related files, 47

Tests
running, 64

selecting, 32
setting up, 55

U

Untitled session folder, 7
User account setting (Windows 7), 5

User comments

location in reports, 52
User Comments

including in reports, 51
User Defined Mode, 40, 55

vV

View probes (acquisitions), 38

W

Waveform files
locating and storing, 47
Windows 7 user account setting, 5
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